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Chapter 1 - Introduction
Congratulations on the purchase of your new Dolphin® 9500/9550 mobile computer! 

You have made a wise choice in selecting the Dolphin, a device known worldwide for its ergonomic shape, light-weight, rugged 
design and single-handed data collection capabilities. [COMMENT ABOUT THE ADDITIONAL BENEFITS OF SOFTWARE/OS 
CAPABILITIES “The Dolphin 9500/9550 is a true mobile computing device with enhanced software application capabilities to suit 
your data collection needs”]

Ergonomics 

The patented shape of the Dolphin 9500 fits into either hand comfortably with major function keys that are easy to access. The 
hand strap on the back panel ensures a secure hole enabling true, one-handed operation. The integrated pistol-grip handle on 
the Dolphin 9550 provides intuitive point-and-shoot scanning over extended periods of use. 

Rugged Design

Dolphin 9500/9550 terminals are some of the most durable on the market. Their rugged design can withstand repeated five-foot 
drops onto a concrete floor, extreme temperatures, and high humidity, moisture, and dust conditions.

Mobile Computing

Built to last, the Dolphin’s durably built case houses 

• A 400MHz RISC processor for fast processing
• The Microsoft® Pocket PC operating system that is easily programmable with standard programming tools, 
• eMbedded Visual Tools (includes eMbedded Visual C/C++® and eMbedded Visual Basic®) or Visual Studio.NET (Visual 

Basic.NET or Visual C#.NET). 
• 64 MB RAM and 32 MB FLASH memory configuration for ample, secure data storage,
• An optional secure digital card for up to 256MB additional memory 

Load up the Dolphin with your custom software application and the ultimate data collection solution for your business fits in the 
palm of your hand!

Additional Features

The Dolphin 9500/9550 features: 

• Long-lasting Lithium Ion (L-Ion) batteries,
• A large easy-to-read 1/4 VGA backlit display (240 x 320) that can display text or graphics, 
• A low-power, high-resolution digital image engine for omni-directional and auto-discrimination decoding of linear bar codes,
• Stacked Linear and matrix codes,
• Digital picture capability, 
• Optical Character Recognition (OCR) functionality, and 
• Co-existing 802.11b and/or Bluetooth radios for real-time data collection applications (optional).

This user guide

TheDolphin 9500/9550 Mobile Computer User Guide is designed to provide you with the information you need to make the most 
of your Dolphin terminal. Sections on the basics, safety, battery use, accessories, and service make this guide a complete source 
of information.
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Chapter 1 - Introduction Safety
Safety

The Dolphin 9500/9550 mobile computer meets or exceeds the requirements of all applicable standards organizations for safe 
operation. However, as with any electrical equipment, the best way to ensure safe operation is to know the possible risks. 

The following safety guidelines are designed to protect both you and others around you. Please read them carefully before using 
your Dolphin terminal.
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Chapter 1 - Introduction Required Safety Labels
Required Safety Labels

If Your Dolphin 9500/9550 is a Batch Terminal with an Imager
The following is the required safety label that appears on the back panel of Dolphin 9500/9550 batch terminals equipped with an 
imager.

If Your Dolphin 9500/9550 has a WLAN radio
The Dolphin® 9500/9550 RF terminal is designed to comply with the most current applicable standards on safe levels of RF 
energy developed by the Institute of Electrical and Electronics Engineers (IEEE) and the American National Standards Institute 
(ANSI) and has been recommended for adoption by the Federal Communications Commission (FCC). 

802.11b and Imager

The following is the required safety label that appears on the back panel of the Dolphin 9500/9550 RF terminals equipped with 
a 802.11b radio and an imager.   

Bluetooth

The following is the required safety label that appears on the back panel of the Dolphin 9500/9550 RF terminals equipped with 
a Bluetooth radio and an imager.
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Chapter 1 - Introduction FCC Compliance
FCC Compliance 

Dolphin 9500/9550 Batch Terminal
The Dolphin 9500/9550 Batch complies with part 15 of the FCC rules. Operation is subject to the following two conditions:

1 Devices may not cause harmful interference.

2 Devices must accept any interference received, including interference that may cause undesired operation.

Dolphin 9500/9550 RF Terminal with 802.11b or Bluetooth Radio
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:(1) this device may not 
cause harmful interference, and (2)this device must accept any interference received, including interference that may cause 
undesired operation.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user 
may find the following booklet helpful: “Something About Interference.” This is available at FCC local regional offices. Our 
company is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the 
substitution or attachment of connecting cables and equipment other than those specified by our company. The correction will 
be the responsibility of the user. Use only shielded data cables with this system.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

CAUTION: To comply with FCC RF exposure compliance requirements, a separation distance of at least 2 inches (5 cm) 
must be maintained between the antenna of this device and all persons (excluding hands, wrists, feet and ankles), 
during normal operation.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or transmitter.

This device is not specified or designed for body-worn configurations. Use of any body-worn accessories may not 
ensure compliance with the FCC RF exposure guidelines.

Canadian Compliance
This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 1 - 4



Chapter 1 - Introduction Regulatory and Safety Agency Approvals
Regulatory and Safety Agency Approvals

The CE mark on the product indicates that the system has been tested to and conforms with the provisions noted within the 89/
336/EEC Electromagnetic Compatibility Directive and the 73/23/EEC Low Voltage Directive.

Dolphin 9500/9550 RF Bluetooth R&TTE Compliance Statement
The HHP Dolphin 9500RF and Dolphin 9550RF are in conformity with all essential requirements of the R&TTE Directive (1999/
5/EC). This equipment has been assessed to the following standards:

This product is marked with    in accordance with the Class II product requirements specified in the R&TTE 

Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community, but it’s authorization for use in France is restricted as 
follows:

PAN European Frequency Range: 2.402 - 2.480 GHz

Restricted Frequency Range for use in France: 2.448 - 2.480 GHz

Parameter Specification

RF Approvals

U.S.A
Canada
Europe
Mexico

FCC Part 15.247
RSS 210 Certified
ETS 300 328 Certified
Telecom RCPHAD002-485

Parameter Specification

R&TTE EN 300 328-2:2000
EN 301 489-1 (August 2000)
EN 301 489-17 (Sept. 2000)
EN 60950: 1992 Incl Amdt 1-4,11
EN 50361: 2001
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Chapter 1 - Introduction Dolphin 9500/9550 RF 802.11b R&TTE Compliance Statement
Dolphin 9500/9550 RF 802.11b R&TTE Compliance Statement

The HHP Dolphin 9500RF and Dolphin 9550RF are in conformity with all essential requirements of the R&TTE Directive (1999/
5/EC). This equipment has been assessed to the following standards:

This product is marked with    in accordance with the Class II product requirements specified in the R&TTE 
Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community, but its authorization for use in France is restricted as 
follows:

PAN European Frequency Range: 2.402 - 2.480 GHz

Restricted Frequency Range for use in France: 2.448 - 2.480 GHz

Pacemakers, Hearing Aids and Other Electrically Powered Devices
Most manufacturers of medical devices adhere to the IEC 601-1-2 standard. This standard requires devices to operate properly 
in an EM Field with a strength of 3V/m over a frequency range of 26 to 1000MHz. 

The maximum allowable field strength emitted by the Dolphin is 0.3V/m according to Subpart B of Part 1 of the FCC rules. 
Therefore, the Dolphin RF will have no effect on medical devices that meet the IEC specification. 

Microwaves
The radio in the Dolphin RF terminal operates on the same frequency band as a microwave oven. Therefore, if you use a 
microwave within range of the Dolphin RF terminal you may notice performance degradation in your wireless network. However, 
both your microwave and your wireless network will continue to function.

The Dolphin Batch terminal does not contain a radio, and therefore, is not affected by microwave ovens.

Parameter Specification

R&TTE EN 300 328-2:2000
EN 301 489-1 (August 2000)
EN 301 489-17 (Sept. 2000)
EN 60950: 1992 Incl Amdt 1-4,11
EN 50361: 2001
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Chapter 1 - Introduction Batteries
Batteries

The following are general guidelines for the safe use and disposal of batteries:

• Use only the battery supplied with your Dolphin or a replacement battery supplied, recommended, or approved by HHP. 
• Replace a defective battery immediately as it could damage the Dolphin terminal.
• Never throw a used battery in the trash. It contains heavy metals and should be recycled according to local guidelines. 
• Don’t short-circuit a battery or throw it into a fire. It can explode and cause severe personal injury.
• Excessive discharge damages a battery. Recharge the battery when your Dolphin indicates low battery power.
• Although your battery can be recharged many times, it will eventually be depleted. Replace it after the battery is unable to 

hold an adequate charge.
• If you are not sure the battery or charger is working properly, please send it to HHP or an authorized HHP service center, for 

inspection. 

The Dolphin hand held computer meets or exceeds all applicable standards and has been manufactured to the highest level of 
quality.
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Chapter 1 - Introduction Care and Cleaning of the Dolphin 9500/9550
Care and Cleaning of the Dolphin 9500/9550

When needed, clean the image engine window and the LCD display with a clean, non-abrasive, lint-free cloth.
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Chapter 2 - Getting Started
Overview

The Dolphin 9500/9550 mobile computer/imager is designed for easy, single-handed mobile data collection. Each terminal is 
equipped with a PXA255 400MHz RISC processor built to run the Windows® Pocket PC platform.

Dolphin 9500/9550 computers are available with different types of 2D imagers, wireless radios, and memory configurations to 
meet most any mobile data collection requirement. 

Offered with a memory configuration of 64 MB RAM and 32 MB non-volatile FLASH, the device has three keyboard options and 
a 240 x 320 pixel, backlit 1/4 VGA display available in color or monochrome. 

The Dolphin 9500/9550 platform contains an integrated imager that can take images such as shipping manifests and recipient 
signatures in addition to decoding standard linear and two-dimensional symbologies. 

Adapting the Dolphin to your environment

The Dolphin 9500/9550 terminal comprises one element of an enterprise data collection system. The 9500 line includes various 
models, peripherals, and accessories that you can combine to suit your exact needs.Dolphin 9500/9550. 
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Chapter 2 - Getting Started Dolphin 9500/9550 Models and Options
Dolphin 9500/9550 Models and Options

HHP’s family of Dolphin 9500/9550 mobile data collection terminals includes these models:

The Dolphin 9500 Batch terminal 

This is a Windows® Pocket PC programmable mobile computer with a unique, ergonomic shape designed for single-handed use. 
The standard Dolphin 9500 is available with 64 MB RAM and 32 MB FLASH and integrated digital imager. An optional secure 
digital card offers up to 256MB of additional memory. The terminal's connector supports RS-232 and USB communications, 
external plug-in scanners, land line modems, and printers. It also features an IrDA infrared port to communicate data to portable 
printers and IrDA compliant devices.

The Dolphin 9550 Batch 

This mobile computer offers the same enhanced productivity features of the Dolphin 9500 terminal with the added convenience 
of an integrated pistol grip-style form factor for high volume scanning applications. 

The Dolphin 9500 RF and Dolphin 9550 RF 

These terminals integrate the basic functionality of the Batch terminals with the choice of an 802.11b direct sequence radio that 
allows the terminal to communicate with a host computer via a radio wireless local area network (WLAN).

The Dolphin 9500/9550 WPAN 

This terminal allows Bluetooth communications to Bluetooth enabled devices such as printers, mobile phones, access points, 
Bluetooth enabled PC’s, etc. 

Image Engine Options 
Dolphin 9500/9550 terminals may be equipped with one of the following: 

• IT4000 SR: red or green aimer option scans from 2.5 to 12.5 in. (6.3 to 32 cm.) 
• IT4000 SF: red or green aimer option scans from 2.1 to 8.3 in. (5 to 21 cm.)   
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Chapter 2 - Getting Started Dolphin 9500/9550 Peripherals
Dolphin 9500/9550 Peripherals 

Each of the following items is sold separately to enhance your Dolphin 9500/9550 terminals capabilities. 

Dolphin HomeBase™

A charging and communication cradle for communicating with host systems through an RS-232 serial port or USB port. 
Designed for stationary environments, it features an auxiliary battery well and power cable. 

See Dolphin 9500/9550 HomeBase™ on page 12-1.

Dolphin Mobile Base 

A charging and communication cradle for communicating with host systems through an RS-232 serial port or USB port. 
Designed for use in mobile environments, it features a flexible mounting bracket, a cigarette lighter adapter, and power 
cable.

See Dolphin Mobile Base on page 14-1..

Dolphin QuadCharger™ 

Charges four batteries in under four hours.

See Dolphin QuadCharger on page 13-1..

Li-Ion Battery Pack  

7.4v, 14.8 watt hour Lithium Ion rechargeable battery for the Dolphin. [does this go here?]

Contact HHP for more information. For details about how to install or use any of these peripherals, refer to the documentation 
provided with the product. Documentation may also be downloaded from our website www.hhp.com. 
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Dolphin 9500/9550 Accessories

Each of the following items is sold separately to enhance your Dolphin 9500/9550 terminals capabilities.

Dolphin HomeBase Power Adapter   

Replacement power adapter for Dolphin HomeBase. 

Charging/Communication Cables  

SB and serial versions that connect the Dolphin 9500/9550 directly to both a peripheral device and a power source.

Dolphin Mobile Charger  

Plugs the terminal directly into a vehicle cigarette lighter for power and battery charging. This accessory converts the 
12 Volts out of the vehicle to the 9 Volts required by the terminal.

Protective Enclosure

Wraps around the terminal to protect it from wear and tear.

Protective Holster

Secures the terminal for mobile use.

Dolphin Mobile Mounting solution

Contact HHP for more information. For details about how to install or use any of these accessories, refer to the documentation 
provided with the product. Documentation may also be downloaded from our website www.hhp.com. 
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Bar Code Symbologies Supported 

1D symbologies Code 3 of 9, Interleaved 2 of 5, EAN, Codabar, Code 11, Code 128, Code 93, TCIF Linked Code 39 
(TLC39), Universal Product Code (UPC), RSS. 

2D symbologies DF417, MaxiCode, Data Matrix, QR Code, EAN·UCC, Aztec Code, Code 49. 

Composite codes RSS-14, Codablock F, Aztec Mesa. 

OCR codes OCR A and OCR B.

Postal codes Postnet and most international 4 state codes, Planet Code, British Post, Canadian Post, KIX 
(Netherlands) Post, Australian Post, Japanese Post.
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Using the Dolphin 9500/9550 for the First Time

Follow these steps to begin using your Dolphin 9500/9550 terminal.

1 Unpack and check the terminal and documentation.

2 Charge the main battery pack and internal back-up battery. 

3 Start the Dolphin mobile computer. 

4 Follow the Pocket PC set-up instructions to setup the mobile computer.

5 Verify that the Dolphin 9500/9550 terminal is working properly.

Step 1. Unpack the Carton and Check Its Contents
Inspect the package to see that the following standard items and accessories (if ordered) are included: 

• Dolphin 9500/9550 mobile computer
• Battery (7.4v Li-Ion)
• Dolphin 9500/9550 Software Development Kit & User’s Guide CD-ROM
• Microsoft companion CD-ROM
• Dolphin 9500 Quick Start Guide
Note: Be sure to keep the original packaging in the event that the Dolphin terminal should need to be returned for service.

Step 2. Charge the Main and Backup Batteries
WARNING! Use only battery packs provided by HHP. The use of any other battery pack in the Dolphin 9500/9550 

terminal will void your warranty and may result in damage to the Dolphin terminal or battery. 
The terminal’s Li-Ion battery is shipped discharged of all power and must be charged for at least four hours 
before initial use. The battery may be charged using the HomeBase, the serial charging cable, or the USB 
charging cable. 

Charging the Battery Using the HomeBase

1 Place the main battery pack in the Dolphin 9500/9550 terminal.

2 Place the terminal in the terminal well of the Dolphin HomeBase. The battery begins charging immediately.

3 Place the backup battery in the auxiliary battery well of the HomeBase. It begins charging immediately.

Note: Time to Charge: Four hours for the main battery in the terminal; 8 hours for the back-up battery.

Charging the Battery Using the Serial/USB Charging Cable

Plug cables into terminal connector, plug adapter into wall outlet

As the main battery pack charges, the internal back-up battery also charges. The back-up battery maintains the RAM and clock 
when the terminal’s main battery pack is discharged or removed from the terminal. 

Removing the Battery Pack

Follow these steps to remove the Dolphin battery pack.

1 Hold the Dolphin with the front panel (keyboard) facing down.

2 On the Dolphin 9500/9550 terminal, remove the handstrap by pushing its clip down and forward to unhook it from the 
terminal; move the strap away from the battery compartment.

3 Push the locking tab on the battery pack up and pull the battery out from the Dolphin terminal with a hinging motion.

Installing the Battery Pack

Follow these steps to install the Dolphin 9500/9550 battery pack.

1 The Dolphin 9500/9550 ships with the handstrap installed. Hold the terminal with the front panel (keyboard) facing down. 
Push the clip of the handstrap down and away from the terminal to unhook it; move the strap up and away from the battery 
compartment.
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2 Insert the end without the locking tab into the top of the battery opening and snap the battery into place with a hinging motion. 
Press the battery into the well until the clip is engaged. The battery case serves as the back cover of the Dolphin.

3 Reattach the handstrap by positioning it down over the battery case and sliding the clip back into the place at the bottom end 
of the Dolphin 9500/9550.

Step 3. Start the Dolphin 9500/9550 Mobile Computer
Follow these steps to start your Dolphin 9500/9550 mobile computer.

1 Install the charged battery pack in the Dolphin.

2 The red LED will come on and the green LED will blink for approximately three seconds.                                                                                                                      
NOTE: DO NOT PRESS ANY KEYS WHILE THE TERMINAL IS BOOTING UP. 

3 The terminal initializes and the HHP splash screen displays for a few seconds.

4 The system performs a hard reset.

5 Follow the instructions that appear when the display activates again.

Build: 5.XX/5.XX/5.XX

Bootloader Kernel Keyboard
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Step 4. Align the Screen 
After a hard reset, you are prompted to align the screen:

• Use the stylus shipped with your Dolphin terminal to tap the target wherever it appears on the screen.
Alignment should always be performed with a stylus designed for touchscreen applications. The small point is required for 
accurate calibration. The stylus should be oriented at a 90 degree angle to the screen surface.

• Press the stylus firmly into the center of the cross-hair target once and release. Do not “double-tap” the target. You will be 
prompted to repeat this process for a total of five targets.

Note: You can align the screen at any time in the future by going to Start > Settings > System tab > Screen > Align Screen. 

After aligning the screen, follow the directions on the screen which take you through a simple exercise showing how to use the 
stylus and pop-up menus.

Note: HHP recommends using screen protectors for Dolphin 9500/9550 terminals; especially for those terminals used 
within applications that require high-volume interfacing with the touch display. Screen protectors help prevent 
damage to the touch panel display and are easily installed over it. Screen protectors can be purchased at any 
major computer retail store.

Tap the Target
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Step 5. Set the Time Zone
After screen alignment is completed, the Location screen shown below displays.  

Use the drop-down menu to select your time zone, and tap Next. This does not necessarily set the correct time; only the time 
zone. You set the time and date manually. See Setting the Time and Date on page -11..

After setting the time zone, you are finished with the initial setup of your Dolphin mobile computer. The system begins 
autoinstalling.

Step 6. Autoinstall
After setting the time zone, your Dolphin 9500/9550 begins installing programs automatically. For each set of programs that load, 
you should see a small install screen with a bar going across to indicate that a program is loading. Wait until the last program 
loads and you should see the starting screen.

Programs installed 

All configurations of the Dolphin 9500/9550 install the HHP Demos and HHP utilities. If the terminal is RF or Bluetooth, the 
appropriate radio drivers and utilities for each radio install.

Setting Time Zone 
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Warm boot
When the autoinstall is complete, the system performs a warm boot. When back on, the terminal opens to the starting screen.
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Setting the Time and Date

It is a good idea to set the time and date now before you begin using the device. You must set the time zone first. 

To set the time and date, go to Start > Settings > Systems tab > Clock to set the date and time.

Note: You need to re-set the time and date after every hard reset of the terminal.

Step 7. Verifying That Your Dolphin 9500/9550 is Working Properly
After you have completed the initial setup and set the time and date, the Dolphin 9500/9550 terminal is ready to use. Run the 
Image and/or Scan demo to verify that the terminal is operating properly and test the imaging functionality.

To verify imaging:

1 Go to Start > HHP Demos > Image Demo . 

2 Press the SCAN key. A preview of the image appears on the terminal’s screen. 

3 Release the SCAN key. The image is captured.

4 Press the ESC key to go back to the main menu.

To verify scanning:

1 Go to Start > HHP Demos > Scan Demo .

2 Press the SCAN key, aim the terminal at a bar code and the red SCAN LED illuminates. When a good scan is obtained, the 
green SCAN LED illuminates and the terminal beeps. Information about the bar code scanned appears on the screen. 

3 Press the ESC key to exit the demo and return to the main menu. 
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Putting the Dolphin in Suspend Mode
To conserve power, press the Power key to put the Dolphin terminal into suspend mode. The terminal may also go into “suspend 
mode” when it is inactive for a programmed period of time, as defined by your application. Press the SCAN key to wake the 
Dolphin terminal from suspend to continue normal operations. 

The Dolphin terminal also goes into sleep mode if you remove the main battery pack. To wake the Dolphin terminal from suspend 
mode, install a charged battery and press the SCAN key. 

WARNING! If the main battery and back-up battery are ever fully discharged of power, the terminal will perform a hard 
reset when power is restored. The terminal will be restored to its original state. All data stored in RAM 
memory will be lost.

Resetting the Dolphin (Hard Reset)
Under some conditions, you may need to reset the Dolphin 9500/9550 terminal with a hard reset. These may include: 

• Resetting the operating system 
• Resetting the terminal back to factory defaults
• Resetting the terminal after a bootloader, keyboard, and kernel upgrade

CAUTION! A hard reset erases all the data stored in RAM memory. You will lose all data.

To perform a hard reset:

1 Press and hold the Control (CTRL) and the Escape (ESC) keys for approximately 10 seconds.

2 Release the keys and the terminal resets. The red LED comes on and the green LED blinks for approximately 3 seconds. 

3 When you turn on the terminal again, it will need to be reconfigured. Refer to Start the Dolphin 9500/9550 Mobile Computer 
on page -7. 

Resetting the Dolphin (Soft Reset)
There are times when you may need to warm boot the Dolphin 9500/9550 terminal, such as after loading a software application 
that requires a warm boot after installing new software. 

To warm boot the Dolphin 9500/9550 terminal:

1 Press and hold the Control (CTRL) and the SHIFT (SFT) keys for approximately 10 seconds, then release. 

2 Release the keys and the terminal resets. The red LED comes on and the green LED blinks for approximately 3 seconds. 

3 The terminal will initialize and after a few seconds will display the Today screen.
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System Features

Processor

The Dolphin 9500/9550 terminal is equipped with an Intel® X-Scale 400MHz RISC microprocessor that runs on a 100 MHz BUS 
and is one of the most powerful Pocket PC platforms on the market.

Operating System

Microsoft® Pocket PC is a compact, highly efficient, scalable operating system. Its open architecture facilitates development of 
applications for energy-efficient data collection devices like the Dolphin 9500/9550 terminal. 

Memory

Main Board

The memory configuration for the Dolphin 9500/9550 terminals is 64 MB RAM and 32 MB non-volatile FLASH.

Secure Digital Card (SD)

Dolphin 9500/9550 terminals have one user accessible secure digital (SD) card interface for additional application and 
data storage capacity. Additional secure digital upgrades of 64 MB, 128 MB, and 256 MB are available. The secure 
digital card socket is user accessible while preserving the terminal’s environmental rating. 

Wireless Radio Options

Radio options for Dolphin 9500/9550 terminals include an integrated 802.11b and integrated Bluetooth wireless network adapter. 
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Front Panel Features

This section describes features on the Dolphin 9500/9550 terminal front panel. 

LEDs

There are two red light emitting diodes (LEDs) located at the top of the LCD display. Both are software programmable.

Scan LED

The LED located in the upper right corner is the Scan LED. It illuminates when you press the SCAN key to activate the 
scan engine.

Decode LED 

The green LED located in the upper left corner of the LCD display is the Decode LED. It illuminates when the bar code 
software successfully decodes a scanned bar code. 
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1/4 VGA Display

The Dolphin 9500/9550 screen is a 240 x 320 pixel, 3.5” 1/4 VGA display with an industrial protective lens. It is equipped 
with a touchscreen that can be activated with a stylus (included with the terminal) or finger.

The display is available in 16-level grayscale monochrome and 262, 144 color TFT versions. 

The backlight for both the electroluminescent, monochrome display and white LED color display enable viewing in low-
light conditions. To conserve power, the backlight can be programmed to automatically turn off after a prescribed 
amount of time; see page 4-15. The contrast may be adjusted with the contrast keys. 

SCAN Key

The SCAN key is centrally located for easy access with the right or left hand. When pressed, the SCAN key activates 
the scan. It also functions as an on or system wakeup control for the terminal.

On the 9550 terminal, scan activation and system wakeup is also activated by pressing the trigger on the handle.

Cursor Keys

The centrally located cursor keys allow full Windows® Pocket PC navigation.

Three Keyboard Options

The Dolphin 9500/9550 keyboards feature durable keys that are backlit for easy use in dark and dim lighting conditions. 
The silver background enhances the readability of the numeric keys. Important keys, such as the SCAN key, are 
centrally located for both right- and left-hand use, easy imaging, bar code scanning, and application navigation. 

There are three keyboard options for the Dolphin 9500/9550 terminals: 

For more specific information about each keyboard, see A on page A-1..

43-key numeric/alpha keyboard35-key numeric/alpha keyboard 56-key alpha/numeric keyboard
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Back Panel Features

Note: The safety labels on the back panel are specific to how each individual terminal is equipped.

Dolphin 9500
This following graphic describes features on the back panel of the Dolphin 9500 terminal.

Note: Because the back panel of the Dolphin 9550 features a pistol-grip handle, it is featured in the following section

Image Engine/Laser Engine Window

Dolphin 9500/9550 terminals come equipped with an image engine that reads and decodes linear, stacked linear 
(PDF417), and 2D matrix bar code symbologies. With the latest CMOS-based technology, the engine works like a digital 
camera and enables digital image capture, signature capture and reading OCR characters. 

Digital images taken with the Dolphin 9500/9550 terminal have a maximum image size of 640 x 480 pixels and may 
have up to a 256 gray scale image definition. Files formats supported for image storage include Bitmap (.bmp), JPEG 
(.jpg) and Portable Network Graphics (.png).

Battery Well

Battery

Image Engine/
Laser Engine 
Window 

Stylus (in slot) Speaker

Microphone

Hand strap
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 3 - 4



Chapter 3 - Dolphin 9500/9550 Overview Dolphin 9500
For a frontal view of the Image Engine/Laser Engine Window,  see Image Engine/Laser Engine Window - front view on 
page 3-6.

Speaker

The Dolphin 9500/9550 terminal has an internal speaker that sounds audio signals as you scan bar code labels and 
enter data. The operating frequency range is 500Hz at 71 dB up to 80 dB. The speaker can also be used for playing 
sounds (e.g., WAV files).

Hand Strap 

The Dolphin 9500 has an integrated elastic hand strap providing a comfortable, secure grip on the terminal. If desired, 
the strap may be adjusted or removed. 

Microphone

Dolphin 9500/9550 terminals feature an internal microphone that provides audio input to the terminal.

Battery/Battery Well

The Battery Well is a recessed area on the back of the Dolphin that holds the Li-Ion battery pack. For more information, 
see Batteries on page 3-10..

Stylus

The stylus is used to operate the touchscreen display. The back panel features this storage slot to hold the stylus when 
not in use. 
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Dolphin 9550
This section describes the back panel of the Dolphin 9550. It contains the same features as the Dolphin 9500 described in the 
previous section with the additions of 

• a pistol-grip handle to hold and maneuver the terminal with greater ease,
• a scanner/imager trigger on the handle that activates the scan, and
• rubber bumpers that enable the terminal to rest safely and securely when not in use.

The following is a graphic of the 9550 bottom panel. 

Rubber Nose Bumpers

See Rubber Nose Bumpers on page 3-7.

Image Engine/Laser Engine Window

This is the front view of the window. For more information, see Image Engine/Laser Engine Window on page 3-4.

Scan Trigger

The scan trigger provides comfortable two-finger scan activation.

Pistol Grip Handle

The comfortable, ergonomic handle is designed especially for use in rapid, high volume scanning applications and 
features rubber surface details for improved handle grip, comfort, and shock absorption.

Rubber Nose 
Bumpers

Pistol-Grip Handle

Scan Trigger

Rubber Bumper

Image Engine/
Laser Engine 
Window - front 
view
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Rubber Nose Bumpers

The rubber bumpers enable the Dolphin 9550 to rest in a stable, nose-down position when the unit is set on a flat 
surface. The following graphic shows the Dolphin 9550 in a nose-down position, resting on its rubber bumpers. 

Stylus

The stylus is used to operate the touchscreen display. The Dolphin 9550 back panel stores the stylus inside the pistol-
grip handle.

Rubber Bumpers Stylus - inside the handle
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Side Panel Features

The following graphic shows the left, side panel.

IrDA Port

The IrDA (Infrared Communications) Port allows the Dolphin to communicate with IrDA-enabled devices such as PC’s, 
printers, modems, or other Dolphin 9500/9550 terminals. The maximum speed is 115kbps.

Secure Digital Memory

Dolphin 9500/9550 terminals have an industry standard Secure Digital (SD) interface. The Secure Digital Access Door 
seals this interface from moisture and particle intrusion and provides secure storage for read/write data. 

The SD is user-accessible. The user can gain access to it by opening the access door manually. 

64K, 128K, and 256K memory cards are available. 

Headphone Jack

Dolphin 9500/9550 terminals contains a 2.5mm audio plug for stereo audio playback. This jack can also serve as a 
standard headset interface for audio/voice.

DO
LP

HIN
 95

00

IrDA Port Secure Digital Access Door Headphone Jack  (2.5mm)
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Bottom Panel Features

This following graphics describe the bottom panel of the Dolphin 9500/9550.

Industrial 17-pin Connector
The bottom panel of the Dolphin 9500/9550 features a custom, industrial 17-pin connector. This serial port is designated as COM 
port 1. When seating in the HomeBase or Mobile Base, the battery in the battery well is charged and the terminal powered 
through this connection. If the base unit is connected to a desktop computer, this connector also transmits data through 
ActiveSync. 

The connection to the peripheral can be RS-232 or USB. The maximum RS-232 speed is 115kbps with seven baud rate settings. 
USB communication runs at 2 Mbps. This port also provides power out (to peripheral devices) at 500mA at 5V.

With the addition of the special cable that connects directly to this serial port, Dolphin 9500/9550 can connect and provide power 
to a peripheral device directly. 

NOTE: SIGNALS REFERENCED FOR A  DTE DEVICE

Pin #        Description

 1                     +USB
 2                      PWR
 3                      N / C
 4                      N / C
 5                      N / C
 6                      N / C
 7                      GND
 8                      5V OUT
 9                      DTR
 10                    -USB 
 11                    USB DET 
 12                    RI
 13                    DSR
 14                    RXD
 15                    RTS
 16                    TXD  
 17                    CTS

1

10

2

11

3

12

4

13

5

14

6

15

7

16

8

17

9

Industrial 17-pin Connector
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Batteries

CAUTION! Use only the 7.4V battery packs provided by HHP. The use of any other battery pack in the Dolphin 9500/9550 
terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

There are two batteries in the Dolphin 9500/9550:

Internal Backup Battery 

Located inside the terminal, this battery backs up the RAM and clock when the Li-Ion main battery is discharged or removed from 
the terminal. The internal backup battery is not user replaceable.

Li-Ion Battery Pack

This battery pack is the primary power source for operating the Dolphin terminal. For the location of the Li-Ion battery on the 
terminal, see Battery/Battery Well on page 3-5.

Internal Li-Ion Backup Battery
The Dolphin’s internal backup battery prevents the terminal from being reset if you need to remove and replace the main battery 
pack. The battery retains RAM data and allows the real-time clock to remain operational for up to 30 minutes when the battery 
pack is removed. 

If the backup battery becomes fully discharged of power after the initial charge cycle, it will require a minimum of 10 hours of 
charging time to perform and maintain the system as described above.

The internal backup battery is charged by the Dolphin’s main battery pack when an external power source such as the Dolphin 
HomeBase, is not available. If the terminal is left without the main battery pack for more than 30 minutes, the internal backup 
battery will need to be recharged. 

Note Data and programs stored in FLASH remain safe even if the internal backup battery fails. However, you must reset the 
real-time clock using the Pocket PC Time and Date function.

Follow these guidelines to maximize the life of the Dolphin’s backup battery:

• Keep a charged Li-Ion battery pack in the Dolphin. The internal battery will prematurely discharge if there is not at least a 
partially charged battery in the terminal.

• Put the Dolphin in the HomeBase connected to power when the terminal is not in use. 

Main Battery Pack
The 7.4V, 14.8 watt hour Lithium Ion (Li-Ion) battery pack is the primary power source for the Dolphin. 

The Li-Ion battery is designed to operate in a temperature range of -10 to 50°C (14 to 122°F). For maximum performance, charge 
the batteries between 10 and 35°C (50 and 95°F).
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Managing Battery Power

Data and files saved on the Dolphin 9500/9550 terminal may be stored in RAM, so it is important to maintain a continuous power 
supply to the terminal. When the main battery pack becomes low, the Low Battery Charge icon will appear in the notification tray 
at the top of the screen. The Critical icon will appear when the battery is critically low. There is also a Low Battery icon that will 
appear when the back-up battery is low.

Letting the back-up battery become fully discharged will cause the terminal to lose all data in RAM. Therefore, you should keep 
a charged battery pack in the Dolphin at all times to conserve the internal back-up battery. When you remove a battery pack, 
insert another charged pack in the Dolphin. The internal battery will prematurely discharge if there is not at least a partially 
charged battery in the terminal. 

The battery status indicator displays in the notification tray when the battery is low or critically low. If there is no indicator, the 
battery is adequately charged.

If the main battery is low and the terminal is in suspend mode, pressing the SCAN or Power button will not wake up the Dolphin 
9500/9550 terminal; you must replace the discharged battery with a fully charged battery.

Setting Critical and Low Battery Points
The Dolphin 9500/9550 may be programmed to display warnings when the battery reaches critical and low battery points. There 
are two entries defined in the registry. The specific settings are:

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power]

“CriticalBatt”=dword:a

“LowBatt”=dword:19

“CriticalBatt”=dword:F 

This sets the Critical Battery point to 15 percent (a hex = 15 decimal). The critical battery is the point at which the customer is 
warned that the battery charge is very low. This warning will be posted every 3 minutes until the situation is corrected.

“LowBatt”=dword:19

This sets the Low battery point to 25 percent (19 hex = 25 decimal). The low battery setting is the point at which the user is alerted 
that the battery is low. The user is notified only once for a low battery.

These are the default values. Developers can set these parameters from 0 (no warning at all) to 99 (would nearly always warn). 
The warnings do not appear when the terminal is on external power.

Checking Battery Power
The Battery Status screen displays information about current battery status and allows you to set options that can conserve 
battery power.

To open the Battery Status screen:

1 Select Start>Settings>System>Power. 

2 Select your preferences.

3 Tap OK to save the changes and exit. 

Charging the Battery Pack
You can charge the Dolphin’s main battery pack with one of the following methods:

• Place the battery pack in the Dolphin 9500/9550 terminal and then place the terminal in the terminal well of a HomeBase or 
Mobile Base.

• Place the battery pack in the Dolphin Quad Battery Charger.
• Place the battery back in the Auxiliary Battery Well of the HomeBase. 
• Connect a charging/communication cable to the Dolphin 9500/9550 terminal and plug into a power outlet.

Storing Batteries
To maintain optimal performance from batteries, follow the guidelines below when storing them:

Avoid storing batteries outside the specified range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.

For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 
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Technical Specifications for the Dolphin 9500

System  Architecture

Processor: Intel® X-Scale PXA255 400MHz 

SDKs:
Dolphin SDK for Pocket PC 2002 with embedded VB or C++, Dolphin .Net SDK for Pocket 
PC 2002 with Visual Studio.Net, VB.Net, C#.NET, and.NET Compact Framework, HHP 
libraries and utilities.

Operating Platform: Microsoft® Pocket PC Professional Edition 

Third-Party Software:
Support for Connect Terminal Emulation software (TNVT, 3270, 5250)-Insignia Solutions 
Jeode JVM 

Memory: 64MB RAM x 32MB Non-volatile Flash 

Data Inputs

Imager/Scanner:
IT4000 SR scans from 2.5 to 12.5 in. (6.3 to 32 cm.) Specifications are for 100% UPC 
Code.

1D Symbologies Read:
Code 3 of 9, Interleaved 2 or 5, EAN, Codabar, Code 128, Plessey, Code 11, Code 93, 
UPC, RSS

2D Symbologies Read: PDF417, MaxiCode, Data Matrix, QR, RSS Composite, EAN.UCC, Aztec, OCR

OCR Fonts: OCR-A, OCR-B

Keyboard:
Three backlit keyboard options:  35-key numeric-shifted alpha, 43-key alpha-shifted 
numeric,  and 56-key full alpha/numeric                                                                                                                                                                                   

Data Outputs

Display:
1/4 VGA (240 x 320 portrait mode) color TFT LCD display with industrial touch panel OR
1/4 VGA (240 x 320 portrait mode) monochrome display with industrial touch panel          

I/O Ports:
Industrial mechanical connector – supports charging and communications (USB & serial) 
via cradles or AC adapter / comm cable, IrDA port-Integrated, Speaker-Integrated, 
Microphone-Integrated, Headset-jack 

Mass Storage: Optional 64MB, 128MB, 256MB Secure Digital (SD) memory - user accessible

Wireless Radio Options

WLAN: IEEE 802.11b DSSS WLAN radio   

WWAN: GSM/GPRS WWAN radio with accessible SIM card  

WPAN: Bluetooth™ radio

Physical 

Dimensions:
9.6"L x 3.45"W x 1.66"D at display (24.53 x 8.76 x 4.23 cm), 2.7"W x 1.5"D at grip (6.9 x 
3.8 cm)

Weight:
Batch: 19.7 oz. (558 gm); WLAN:  20.2 oz. (573 gm), WPAN:  20 oz. (567 gm), WLAN/
WPAN: 20.3 oz. (576 gm)

Operating Temperature:  14 to 122°F (-10°C to 55°C)

Storage Temperature:  -22 to 176°F (-30°C to 80°C)

Humidity:  95% humidity, non-condensing

Electrical Static Discharge: 15 kv on all surfaces

Impact Resistance: Withstands multiple 5ft. (1.5m) drops onto concrete 

Environmental Resistance: Independently certified to meet IP-64 standards for moisture and particle resistance
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Chapter 3 - Dolphin 9500/9550 Overview Technical Specifications for the Dolphin 9500
Power: Lithium-Ion battery technology – 7.4V, 14.8 watt-hour main battery

Other: Integrated ergonomic stylus – optional tether; removable, integrated hand strap 

Peripherals/Accessories

Dolphin HomeBase™ Charging/communications cradle. Data transfer via RS-232 serial or USB port. 

Dolphin Mobile Base 
Charging/communication cradle. Data transfer RS-232 serial or USB port. Powers out at 
5 volts.

Dolphin Mobile Charger  Plugs into vehicle cigarette lighter for charging.

Dolphin NetBase ????????????

Cables USB and serial

Li-Ion Battery Pack   7.4v, 14.8 watt hour Lithium Ion rechargeable battery for the Dolphin.

Dolphin QuadCharger™ Charges four batteries in under four hours. One slot doubles as an analyzer.

Regulatory Approvals

FCC-CE-Radio Country:  US/Canada, R&TTE

Dolphin, HomeBase, and QuadCharger are trademarks of HHP.  
Microsoft, Windows, and the Windows Logo are registered trademarks or trademarks of Microsoft Corporation. 
Intel is a registered trademark of Intel Corporation.  
The BLUETOOTH trademarks are owned by Bluetooth SIG, Inc., U.S.A. and licensed to HHP.

Technical Specifications for the Dolphin 9500
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Chapter 4 - Using the Dolphin 9500/9550 Mobile Computer
Entering Data

To enter data, you may: 

• Use the 35-key, 43-key or 56-key keypads
• Use the soft input panel (SIP) to enter typed text, either by using the soft keyboard or other input method.
• Write directly on the screen.
• Draw pictures on the screen.
• Collect images or scan bar code data into data fields
• Use Microsoft ActiveSync to synchronize or copy information from your desktop computer to your device. For more 

information on ActiveSync, see ActiveSync Help on your desktop computer.

Entering Text Using the Input Panel 
HHP recommends using screen protectors for Dolphin 9500/9550terminals to protect the input panel display; especially for those 
terminals used for applications that require high-volume interfacing with the touch display. Screen protectors will help prevent 
damage to the touch panel display and are easily installed over the display. Screen protectors can be purchased at any major 
computer retail store.

Note: For touch screen input, only use a stylus or your finger. Use of other objects, such as paper clips, pencils, or ink pens can 
damage the input panel and will void the warranty.

Use the input panel to enter information in any program on the Dolphin mobile computer. You can either type using the soft 
keyboard or write using Letter Recognizer, Block Recognizer, or Transcriber (if installed from the Dolphin 9500/9550Companion 
CD). In either case, the characters appear as typed text on the screen. 

To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input Panel button to see your choices.

When you use the input panel, your terminal anticipates the word you are typing or writing and displays it above the input panel. 
When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your Dolphin 9500/9550 
terminal, the more words it learns to anticipate.

To change word suggestion options, such as the number of words suggested at one time, tap Start> Settings>Personal 
>Input> Word Completion tab.

Input Panel button.

Select an input method.

Tap to see your choices.
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Chapter 4 - Using the Dolphin 9500/9550 Mobile Computer Input Panel Options
Input Panel Options

Using the Soft Keyboard

1 Tap the arrow next to the Input Panel button and then Keyboard.

2 On the soft keyboard that is displayed, tap the keys with your stylus.

Tap here if this
is the right word.
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Chapter 4 - Using the Dolphin 9500/9550 Mobile Computer Using the Letter Recognizer
Using the Letter Recognizer
With Letter Recognizer you can write letters using the stylus just as you would on paper.

1 Tap the arrow next to the Input Panel button and then Letter Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Letter 
Recognizer, with Letter Recognizer open, tap the question mark next to the writing area.

Using the Block Recognizer
With Block Recognizer you can input character strokes using the stylus that are similar to those used on other devices.

1 Tap the arrow next to the Input Panel button and then Block Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Block 
Recognizer, with Block Recognizer open, tap the question mark next to the writing area.

Selecting Text
To edit or format typed text, select it by dragging the stylus across the text. You can cut, copy, and paste text by tapping and 
holding the selected words and then tapping an editing command on the pop-up menu, or by tapping the command on the Edit 
menu.
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Writing on the Screen
In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can 
use your stylus to write directly on the screen as you would on paper. You can edit and format what you’ve written and convert 
the information to text at a later time.

To write on the screen, tap the Pen button to switch to writing mode. This action displays lines on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how 
to switch to writing mode.

To select writing
If you want to edit or format writing, you must select it first.

1 Tap and hold the stylus next to the text you want to select until the insertion point appears.

2 Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. You can also select text by tapping the Pen button 
to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold the selected words and then 
tap an editing command on the pop-up menu, or tap the command on the Edit menu.

Tap the Pen button and use
your stylus like a pen.
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Convert Writing to Text
To convert writing to text, tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping Recognize on the Tools menu (or tap and hold the selected 
words and then tap Recognize on the pop-up menu). If a word is not recognized, it is left as writing.

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.
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Alternate words
If the conversion is incorrect, you can select different words from a list of alternates or return to the original writing. To do so, tap 
and hold the incorrect word (tap one word at a time). On the pop-up menu, tap Alternates. A menu with a list of alternate words 
appears. Tap the word you want to use, or tap the writing at the top of the menu to return to the original writing. 

Tips for Getting Good Recognition
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and apostrophes below the top line so that 

they are not confused with the word above. Write periods and commas above the line.
• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so that the device can easily tell where words begin and 

end.
• Hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to recognize the word, the writing 

you add will not be included if you attempt to recognize the writing again. 

Or, tap the word you want
to use.

Tap to return to your
original writing.
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Drawing on the Screen

Drawing on the screen is similar to writing on the screen. The difference between writing and drawing on the screen is how you 
select items and how they can be edited. 

To create a drawing, cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching the 
drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

For example, selected drawings can be resized, while writing cannot.

Note: You may want to change the zoom level so that you can more easily work on or view your drawing. Tap Tools and then 
a zoom level.

Selecting a Drawing
To edit or format a drawing, tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, 
deselect the Pen button and then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and then tapping an editing 
command on the pop-up menu, or by tapping the command on the Edit menu. To resize a drawing, make sure the Pen button 
is not selected, and drag a selection handle.

The drawing box indicates
the boundaries of the drawing.

Pen button.
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used messages into the text entry area. 
To insert a message, tap My Text and tap a message.

Note: You can add text after inserting a My Text message before sending it.

To edit a My Text message, in the Tools menu, tap Edit and then tap My Text Messages. Select the message you wish to edit 
and make desired changes.

Via the Keyboard
Data can be entered into the Dolphin 9500/9550 terminal via the keyboard. The Dolphin 9500/9550 has three keyboard options: 
43-key alpha shifted numeric, 35-key numeric shifted alpha, and 56-key full alpha/numeric.

To enter data, press the appropriate key and the corresponding number or letter appears on the screen. 

Refer to A for a list of keyboard shortcuts for navigating the keyboard.

Tap to select a
prewritten message.

Using My Text
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Imaging

Dolphin 9500/9550 terminals are equipped an image reader that reads 1D and 2D bar codes, OCR characters and can capture 
images, such as signatures and gray scale pictures. The imager features a green aiming beam that is used to aim the image 
reader against the bar code or item being read.

The terminal supports two types of image decoding for use in various bar code reading and imaging applications: full-area 
imaging and Advanced Linear Decoding (ALD).

Full-area imaging

Full-area imaging provides omni-directional reading of linear and non-linear 1D and 2D bar codes, OCR, signature capture, and 
picture taking. When reading all bar code types using full-area imaging, a positive read can be obtained from most any position. 
To achieve the best read, the aiming beam should be centered horizontally across the bar code. 

ALD

ALD provides fast reading of linear and stacked linear bar codes.  To achieve a positive read when reading linear 1D and PDF417 
bar codes, the imager’s aiming beam should be centered horizontally across the bar code. 

When ALD is enabled, the reader does not read matrix or postal coded.

Decoding method
The decoding method used in a particular scanning or image capture application is determined by the application developer and 
cannot be changed by the end user. 

Decoding a car code - aiming the beam

1 Press the SCAN key on the Dolphin 9500/9550 to project the imager’s green aiming beam. The aiming beam should be 
oriented in line with the bar code to achieve the quickest read. A range of 4-10 inches (10-25 cm) is recommended. 

2 Center the aiming beam over the bar code. The red Scan LED illuminates when the user presses the SCAN key, and the 
green Decode LED illuminates when a bar code is successfully decoded and the terminal beeps.

Note: On the Dolphin 9550, you can use the Scan Trigger instead of the SCAN key. For more information, see Scan Trigger on 
page 3-6.

DOLPHIN 9500

Scan LEDDecode LED
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Chapter 4 - Using the Dolphin 9500/9550 Mobile Computer Decoding a car code - aiming the beam
Refer to the following chart for beam angle information 

The aiming beam is smaller when the terminal is held closer to the code and larger when it is farther from the code. Symbologies 
with smaller bars or elements (mil size) should be read closer to the unit. Symbologies with larger bars or elements (mil size) 
should be read farther from the unit.

Linear bar code 2D Matrix symbol
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Capturing Images
The image-capture process is an intuitive, split-second operation for experienced users. By following the basic guidelines, new 
users can easily develop their own technique and, with practice, quickly learn to adapt it to different circumstances. 

Image preview

When the scan process is initiated, the Dolphin 9500/9550 displays a preview of the image on the touchscreen. This is a live 
video image of what the imager is currently viewing. This enables you to improve your aim and verify the image before you take it. 

The live video preview has a slightly degraded appearance compared to the captured image. This is normal.

The Scan key 

The Scan key captures images on both the Dolphin 9500 and the Dolphin 9550 terminals. It is the only way to capture an image 
on the 9500, while on the 9550, you can also use the scan trigger on the pistol-grip handle. The following highlights both methods. 

Image quality and file size

The image quality and related file size are determined by the data compression method used by your software application.  When 
first captured, the image is saved in the JPEG file format. The average size will be approximately 4-8 K. However, the size of 
each JPEG depends on the content of each image–the more complex the content, the larger the file size. 

For the highest quality (and often the smallest file size), take grayscale images.

To capture images on the Dolphin 9500 

Complete these basic steps:

1 To aim, point the display end of the Dolphin 9500 straight on the target. 

2 Press the SCAN key to preview the image. A live video image appears on the terminal screen. Use it as a guide while you 
position and aim the terminal. You may find it helpful to start by moving the terminal away from and then closer to the target.

3 When the desired image is displayed on the terminal screen, release the SCAN key to capture the image. 
For best results hold the Dolphin terminal as still as possible when you release the SCAN key.

To capture images on the Dolphin 9550 

Complete these basic steps:

1 Holding the pistol-grip handle in either hand, point the display end of the 9550 directly at the target.

2 Press and hold the Scan Trigger to preview the image. A live video image appears on the terminal screen. Use it as a guide 
while you position and aim the terminal. You may find it helpful to start by moving the terminal away from and then closer to 
the target.

3 When the desired image is displayed on the terminal screen, release the Scan Trigger  to capture the image. 
For best results hold the Dolphin terminal as still as possible when you release the SCAN key.

Note: As noted above, you can also use the SCAN key as directed for the Dolphin 9500.
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Communication Media Options

Via the Industrial Connector

The 17-pin industrial connector supports USB and serial communications. Its power output is 500mA at 5V. When connected 
properly, it enables the user to connect the Dolphin 9500/9550 terminal to external devices such as scanners and printers. 

For more information about the 17-pin industrial connector, see Bottom Panel Features on page 3-9..

Via the IrDA Port

The IrDA port allows the Dolphin 9500/9550 to send data via pulses of light to and from other IrDA-compliant devices, such as 
printers and PCs or to other Dolphin 9500/9550 terminals. 

Via the 802.11b Radio

The Dolphin 9500/9550 may be equipped with a WiFi®-compliant, interoperable 2.4 GHz 802.11b direct sequence spread 
spectrum wireless local area network (WLAN) radio.

Via Bluetooth Radio

The Dolphin 9500/9550 may be equipped with a Bluetooth personal area network (PAN) radio.

Software Communication Programs

Microsoft® ActiveSync®

In the Dolphin 9500/9550 Microsoft® development environment, ActiveSync® is a tool for developers. It allows Pocket PC 
devices like the Dolphin 9500/9550 to connect to and exchange data with a desktop computer.

RAS

Short for Remote Access Services, a feature built into Windows NT® that enables users to log into an NT-based LAN using a 
modem, X.25 connection or WAN link. RAS is fully supported and allows the use of PPP or SLIP connections for network 
connectivity.
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Using the Keyboard

The Dolphin 9500/9550 has three keyboard configurations. For details, see Three Keyboard Options on page 3-3.. 

Each keyboard configuration has special keys and key combinations to type characters or perform functions. Refer to the chart 
in A for details. 

Dolphin 9500/9550 43-Key Front View

DOLPHIN 9500
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Using the Cursor Keys
Use the cursor keys to navigate around on an application screen. The use of these keys can vary depending on the application.

Using the Modifier Keys
All three versions of the Dolphin 9500/9550 keyboard feature the standard PC keyboard modifier keys, Shift (SFT), Alt,  and Ctrl. 
To enable single-handed operation, the SFT key modifies only the next key pressed; it must be pressed and released before 
each key you wish to modify.

The Ctrl and Alt keys are located on the bottom row. There are two additional modifier keys located on the bottom row of the 
keyboard: one blue and one red. 

 

Functions of the Alt and Ctl keys depend on the software application in use. 

The blue and red keys are used in combination with other keys to type the corresponding color-coded characters and functions. 
See the chart in A for key combinations for keyboard functions and special characters that use these keys.

The Red and Blue keys modify only the next key pressed; these keys must be pressed and released before each key you wish 
to modify to the Blue or Red case. 

         Press To …

Move the cursor up one row or line.

Move the cursor down one row or line.

Move the cursor one character to the right.

Move the cursor one character to the left.
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Special Keys
SCAN Key The SCAN key activates the scan on both 9500/9550 terminals. It also “wakes” the terminal from 

sleep mode. Its position also allows convenient one-handed image-taking and/or bar code scanning. 

Power Key The Power key puts the terminal into Suspend Mode and also wakes terminal from suspend mode.

Shift (SFT) The Shift key toggles the keyboard from upper case alphabet mode to lower case alphabet mode and 
back. Caps Lock may also be toggled by pressing the red modifier key followed by the Shift key or by 
double-tapping the Shift key. When Caps Lock is toggled on, the Shift key makes characters lower 
case; when it is toggled off, the Shift key makes keys upper case.

Enter (ENT) The Enter key confirms data entry.

Escape (ESC) The Escape key performs a cancel action. 

Tab The Tab key moves the cursor to the next tab stop or the next control on a form. 

Backlight By default, the Backlight key turns the keyboard and display backlights on and off. 

Note      For color displays, when the backlight has turned off, pressing any key on the keyboard turns 
it back on.

The backlight for both the keyboard and the display can be programmed to your specifications by 
going to Start > Settings > Personal tab > Backlight. The Backlight then functions  according to 
your settings.

Number Lock (NUM) This key is included only on the 43-key keyboard option which defaults to alphabetic mode. The 
Number Lock key toggles between the alphabetic and numeric modes. 

Alpha Lock (ALPHA) This key is included only on the 35-key keyboard option which defaults to numeric mode. The Alpha 
key toggles between the numeric and alphabetic modes. 

Backspace (BKSP) This key appears on both the 35 and 56-keyboard options. The Backspace key moves the cursor 
back one space for each time the key is pressed. Backspace is a shifted function on the 43-key 
keyboard version. To delete a single character, press Red key + SP. To delete multiple characters, 
press Red key + SP and hold down the SP key.

Delete (DEL) This key appears on both the 35 and 56-keyboard options. The Delete key deletes one character for 
each time the key is pressed. Delete is a shifted function on the 43-key keyboard version.

Key Combinations 
There are some keyboard functions and special characters not defined on the Dolphin 9500/9550 keyboards or overlays. Refer 
to the charts in A for the key combinations used to access these functions and special characters on your terminal.
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Today Screen

When you turn on your device for the first time each day (or after 4 hours of inactivity), you’ll see the Today screen. You can also 
display it by tapping Start and then Today. On the Today screen, you can see at a glance important information for the day.

Your day at a glance.

Tap to create a new item.

Tap to switch
to a program.

Tap to view notification messages.

Tap to view connection status.

Tap to change date and time.

Tap to open an item.

Tap to change volume or mute all sounds.

Today Screen 
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Following are some of the status icons you may see.

Note: If more notification icons need to be displayed than there is room to display them, the Notification icon, , will display. 
Tap the icon to view all notification icons.

Status Icon Meaning

Turns all sounds on and off 

Backup battery is low 

Main batteries are charging 

Main batteries are low 

Main batteries are very low 

Main batteries are full

Connection is active 

Synchronization is beginning or ending

Synchronization is occurring

Notification that one or more instant 
messages were received

Notification that one or more e-mail 
messages were received
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Selecting Programs

To select a program, tap Start>Programs, then the program name. (You can customize which programs you see on this menu. 
For information, refer to Adjusting Device Settings on page 6-1. 

Note: Some programs have abbreviated labels for check boxes and drop-down menus. To see the full spelling of an abbreviated 
label, tap and hold the stylus on the label. Drag the stylus off the label so that the command is not carried out. 

Start > Programs
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Navigation Bar and Command Bar

The navigation bar is located at the top of the screen. It displays the active program and current time, and allows you to switch 
to programs and close screens. 

Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes menu names, 
buttons, and the Input Panel button. To create a new item in the current program, tap New. To see the name of a button, tap and 
hold the stylus on the button. Drag the stylus off the button so that the command is not carried out.

Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For example, you can use the pop-up menu in the contact list 
to quickly delete a contact, make a copy of a contact, or send an e-mail message to a contact. The actions in the pop-up menus 
vary from program to program. To access a pop-up menu, tap and hold the stylus on the item name that you want to perform the 
action on. When the menu appears, lift the stylus, and tap the action you want to perform. Or tap anywhere outside the menu to 
close the menu without performing an action.

Notifications

Your device reminds you in a variety of ways when you have something to do. For example, if you’ve set up an appointment in 
Calendar, a task with a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your device. 

To choose reminder types and sounds for your device, tap Start>Settings>Personal tab>Sounds & Notifications. The options 
you choose here apply throughout the device.

Tap to select a program.

Tap to change volume or mute the device.

Tap to see additional programs.

Tap to customize the device.

Tap to quickly select a program
you have recently used.

Screen Navigation
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 4 - 19



Chapter 4 - Using the Dolphin 9500/9550 Mobile Computer Finding and Organizing Information
Finding and Organizing Information

The Find feature on your Dolphin mobile computer helps you quickly locate information. On the Start menu, tap Find. Enter the 
text you want to find, select a data type, and then tap Go to start the search.

To quickly find information that is taking up storage space on your device, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device and to organize these files into folders. On the Start menu, tap 
Programs, and then File Explorer.

You can move files in File Explorer by tapping and holding the item you want to move, and then tapping Cut or Copy and Paste 
on the pop-up menu.

Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.

File Explorer
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Chapter 5 - Wireless Communications with Dolphin 9500/9550 
Wireless Local Area Network (WLAN) Communications
Wireless communications with the Dolphin 9500/9550 mobile computer is versatile. Both devices feature co-existing WiFi™ -
compliant 802.11b WLAN and Bluetooth™ WPAN radios integrated into the terminal. That, in addition to the open software 
architecture, make the Dolphin 9500/9550 a complete solution for a variety of wireless mobile data collection applications.

Dolphin 9500/9550 terminals have an on-board 2.4 GHz 802.11b DSSS WLAN radio. The radio uses direct sequence spread 
spectrum (DSSS) technology, which spreads its signal continuously over a wide frequency band, and provides an Ethernet-like 
data rate of up to 11 megabits per second. 

Dolphin 9500/9550 is interoperable with other 802.11b WiFi®-compliant products including access points, printers, PCs via PC-
card adapters and other wireless portable terminals.

Terminology Note

In this manual, the terms “click” and “tap” are used interchangeably. Both mean using the stylus or a finger on the touchscreen 
of the Dolphin 9500/9550 to perform a task. Those tasks usually direct you to click or tap an operation button or icon.
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Choosing a Radio - the Radio Manager 

Purpose

The Radio Manager is a control panel applet through which the radio power driver controls the radio state. It enables you to 
choose which radios in the terminal are powered up. When powered up, the radio is transmitting, when powered down, the radio 
is not transmitting.  

SIngle radio configuration

If your terminal contains a single radio and its associated driver is installed, the radio operates by itself without any special 
configuration made to the device. You can use the Radio Manger to power it down. 

Potential radios

There is a potential for three radios to be installed in the device:

•  Bluetooth, 
• 802.11b, and 
• GSM/GPRS.  [I realize that this is future functionality, but it is relevant here.]

Multiple radio configuration

If multiple radios are installed in your terminal, simultaneous operation must be configured on the device before the radio power 
driver allows it. Configuration of simultaneous radio operation is done during the manufacturing process according to FCC 
regulations. 

Multiple radio operation

GSM and 802.11b are mutually exclusive. While they may both be present, they cannot be allowed to operate simultaneously 
because together they exceed the power supply capability of the terminal.

The Bluetooth radio is allowed to operate by itself or simultaneously with either of the GSM or 802.11b radios after FCC approval 
is obtained.
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Accessing the Radio Manager
Go the Start > Settings > System tab > Radio Manager. The Radio Manager appears identifying which radio modes are allowed 
in the Radio Modes box. The highlighted entry is the radio mode that is currently enabled; its Status should be Ready.   

The Radio Modes box

The Radio Modes box displays the radios currently installed on your terminal. For example, if a working Bluetooth module is 
installed, the box contains the line BlueTooth Only whether or not that radio is currently powered up. (There may be other 
bluetooth related list box entries, but the BlueTooth Only entry is guaranteed to be there if the module is present.)

Powering up a radio
Simply select an entry in the Radio Modes box and click Apply. The Radio Manager issues the radio power driver commands of 
enabling and disabling the radios in the proper sequence. 

For example, let’s say the current mode is BlueTooth Only and the attempt is made to switch to 802.11b Only. After Apply is 
clicked, the Radio Manager turns off the Bluetooth radio first, then turns on the 802.11b radio. 

If an error occurs at either step, the radio mode change is abandoned, and the resulting radio state returns to what is was at the 
time the error occurred. 

Requirements

To successfully power up a radio, its associated driver CAB must have been installed along with the module. If the module is 
present, the radio appears in the Radio Modes box; however if the associated CAB for that module is not installed, you cannot 
successfully enable the radio.

For instance, if the Bluetooth module is present but its CAB has not been installed, BlueTooth Only selection still appears in the 
Radio Mode box. However, attempting to power it up will result in an error in the Status field.

The Status field
The Status field displays error messages when a radio cannot be enabled. When is reads “Ready” the radio selected in the Radio 
Modes box is powered up.
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Errors codes

The following error codes are currently defined and may appear in the Status field after the Apply is clicked:

RP1 and RP2 Should never appear because the Radio Manager control panel applet insulates the user from these 
problems.

RP3, RP5, and RP7 Indicate the specified radio driver did not acknowledge the request to enable or disable the radio. The 
radio state is therefore unknown. This error probably requires a soft reset for recovery (see Resetting 
the Dolphin (Soft Reset) on page 2-12).

RP4, RP6, and RP8 Indicate the specified radio driver rejected the request to enable or disable the radio. The radio is 
therefore still in whatever state it was before the attempt to change it. 

RP9, RP10, and RP11 Indicate the specified radio's CAB has not yet been installed. In this case the radio power driver does 
not try to enable the radio. The corrective action is to install the CAB for that radio. A soft reset may 
be required after the CAB is installed (see Resetting the Dolphin (Soft Reset) on page 2-12).

Error codes Meaning

RP1 Attempt to select an invalid radio mode

RP2 Attempt to change the state of more than 
one radio at a time

RP3 Bluetooth enable or disable timed out

RP4 Bluetooth enable or disable failed

RP5 802.11b enable or disable timed out

RP6 802.11b enable or disable failed

RP7 GSM/GPRS enable or disable timed out

RP8 GSM/GPRS enable or disable failed

RP9 Bluetooth CAB not installed

RP10 802.11b CAB not installed

RP11 GSM/GPRS CAB not installed
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Configuring WLAN Communications 

To open the configuration utility for the 802.11b radio, click Start > Settings > System tab> HHP WLAN Settings . 

The Settings window opens to the Status tab, which displays the current WLAN settings for 802.11b. 

Status tab

Note: You can also click on the Status icon  at any time.

Fields

Current Channel Shows the RF channel currently used by the card.

Current TX Rate Shows the current transmit rate. This can be 1Mb/s, 2Mb/s, 5.5Mb/s, or 11 Mb/s.

Link Quality Gives signal to noise ratio in both percentage and graphical display.

Strength Gives signal strength of the receiver in both percentage and graphical display.

Station IP Info IP Address - IP address of the radio. Check with your network administrator for IP configuration 
information. 

BSS ID/IBSS ID Shows the Network Name and the MAC address of the access point the card is associated with in the 
AP mode. Or it shows the Network Name and the MAC address of the creator of IBSS which the card 
is joined into in the Peer-to-Peer (Ad-Hoc) mode.

Operation buttons

Disable/Enable Radio Click this button in toggle to disable/enable the radio link from the card.

Rescan Click this button to start a rescan process to search for an AP with stronger signal in the network.

Renew IP Click this button to reapply IP address from DHCP server when automatic DHCP is enabled. 
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More Info Click this button to display detailed TCP/IP info; as shown in the following screen: 

Click OK to close this window.

Ping Click this button to open the Ping utility for WLAN.

Ping Utility for WLAN window field descriptions

IP Address Displays the current IP address. You can enter another IP address to ping. 

Size (Bytes) Displays the current bytes size; 32 is the default. You can select up to 8192 from the drop-down list.

Timeout (ms) DIsplays the current timeout; 500 is the default. Increase or decrease it by tapping the spin buttons.

Clear Click this button to clear IP Address input and the ping statistics field. 
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Ping Click this button to ping the IP address entered in the input field. 

Ping Statistics field: Shows the pinging IP address and the pinging results.

Config Tab
The Config tab provides a list of all access points and peer stations associated with the host. Its configuration tool enables you 
to create and edit SSID profiles for access points that you want your station to associate with. 

Fields

Preferred Profiles A list of preferred profiles for access points (AP) in the network created by the user, or added from 
the Active SSIDs table is located at the top of the Config window. When the radio is turned on, it 
searches for the APs with which to associate in the order of the listed profiles. For each profile in the 
table, one can make changes by using the icon tools at top of the table: New, Edit, Delete, Up, and 
Down (Operation buttons on page 5-5). This table is blank after the initial Pegasus software 
installation. It can be kept blank with no automatic association preference.

Active SSIDs The Active SSIDs table lists all access points or peer stations (creator of IBSS) in the vicinity of the 
host. It displays only those SSIDs that accept broadcast associations.

Each record displays information for the following six fields (The table may not display all the fields 
on the screen. Use horizontal scroll bar to check all): 

 SSID - Network Name of the access point or peer station. A link icon with signal strength  is also 
shown.

 Signal Strength in percentage for that SSID.

Mode - An icon shows whether it is an access point , or a peer station .

Channel - The channel it uses and the WEP method it applies if any. The icon  stands for WEP 

Key-On, and  for WEP Key-Off.

SupRate - Supported data rate of the access point or the peer station.

BSSID (MAC Addr) - BSSID or MAC Address of the access point or the peer station.
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Operation buttons

Apply Click the Apply button to associate your station with the SSID you selected. 

This SSID can be either from the Preferred Profile table or from the Active SSIDs list. When applied, 
the Status tab window displays the status of the wireless connection. If the association failed, a 
search for another AP in the Preferred Profile list automatically takes place and the radio attempts to 
associate with the station, in order of preference.

Refresh Click the Refresh button to start a new search for all available access points or peer stations in the 
vicinity.

To add an Active SSID profile to the Preferred Profile table, complete these steps:

1 Select and highlight an SSID from the Active SSID list.

2 Click Add.
If the SSID has WEP Key-On, the Settings window displays and prompts you to enter the WEP Method, Encryption Key, and 
Key ID. 

3 Click OK in the Settings window after finishing the configuration. The SSID and its profile are added into the Preferred 
Profiles window. 
If adding an SSID with WEP Key Off, the Settings window does not display and the SSID is added directly to the Preferred 
Profile table when you click the Add button. 
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Creating and modifying profiles
Use the following five icons at the top of the window:    

To create and add a new profile to the Preferred Profiles list, complete these steps: 

1 Click the New button and the following screen displays:

2 Enter the values for the new profile in the information fields and click OK.

Icon Name Click this icon to…

New  create a profile.

Edit  modify a profile.

Delete delete a selected profile.

Up move the highlighted profile up to increase the automatic association priority.

Down  move the highlighted profile down to decrease the automatic association priority.
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To modify a profile, select one and click the Edit button. The following screen displays:

Note: The SSID, Type, TX Rate, and Channel fields are unchangeable in AP mode, whereas TX Rate and Channel fields can 
be changed in Peer-to-Peer mode.

Network Name & Type 

SSID To enter an SSID, which is the Network Name. Check with your network administrator for Network 
Name (SSID).

Type Choose from Peer-to-Peer or Access Point in the pull down menu. 

Access Point mode is also called “Infrastructure” mode. Peer-to-Peer mode is used for 
communication between two (or more) radio stations (cards) without an access point. 

TX Rate Choose 1Mb, 2 Mb, Auto 1/2 Mb, 5.5 Mb, 11 Mb, or Fully Auto from the menu. The transmit rate is 
Fully Automatic by default. 

Chan Channel. Scroll to select a channel for communication. 

WEP Used to configure the WEP Key for secure wireless communication. Within this block, you configure 
the WEP Method, Encryption Key, and Key ID. 

Use Manual Key Manually input the encryption code for the WEP Key. This is the default setting.

Use Passphrase Generates an encryption code based on the phrase entered in the window. Not available in this 
release.

Method Select one of the five options from the list:

Note: HEX, Hexadecimal number set of 16 digits from 0-9 and from A(a)-F(f). ASCII: Any printable ASCII characters.

Encryption Key Different character set depending on different WEP method and key format.

Key ID Choose from the available options: 

• Disabled WEP Key Off

• 64 bit (HEX) up to 10 characters configurable in Hexadecimal for Encryption Key

• 64 bit (ASCII) up to 5 characters configurable in ASCII for Encryption Key

• 128 bit (HEX) up to 26 characters configurable in Hexadecimal for Encryption Key

• 128 bit (ASCII) up to 13 characters configurable in ASCII for Encryption Key

• Key 1(Default)

• Key 2
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Check with your network administrator for security WEP Key and Key ID you need to use.

Cancel Click this button to close the window without saving or modifying the profile.

OK Click this button to make the change.

Deleting a Profile
Profiles may be deleted either from the Preferred List or from the Preferred List and Registry. To delete a profile, select (highlight) 
a profile and click the Delete button and the following screen displays:

From the pop-up window select the option of your choice and click Yes to confirm or No to cancel. 

Advanced Settings tab
On the Settings window, click the Advanced tab. The following screen displays: 

Information Fields

Power Save Mode

• Key 3

• Key 4
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• Disable - Choosing this option will disable the power save mode.
• Always Enable - Choosing this option will have the power save mode always enabled. This is the default setting.
• Auto Enable - When internal battery is being used it will be in Power Save mode; when external power supply is being used 

the Power Save mode will be disabled automatically.

Authentication Algorithm

Note: Only configurable when the WEP Key is enabled for the SSID profile.

• WECA Compliant (always use Open) - Not available in this release.
• Must use Shared with WEP - AP must use WEP method.
• Automatic based on WEP setting - Default setting.
• Preamble Mode
• Long TX Preamble - Where Sync field consists of 128 bits. 
• Short TX Preamble - Where Sync field consists of 56 bits.
• Auto TX Preamble - Automatically change between long and short preamble mode transmission based on the AP 

configurations. This is the default Preamble Mode.
A Preamble consists of a Synchronization (Sync) field and a 16-bit Start Frame Delimiter (SFD) field.

Operation Buttons

Defaults Resets all the settings to default values (Always Enable for Power Save Mode, Automatic based on 
WEP setting for Authentication Algorithm, and Auto TX Preamble for Preamble Mode).

Undo Cancels the change for setting.

Apply Applies the change to new card setting.

About Tab
This window provides Version Number and time of build for Network Driver, Configuration Utility, and NIC Firmware. Check the 
SyChip website for the latest version.

On the Settings window, click the About tab. The following screen displays: 
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Status Icon

You can access the configuration utility by tapping and holding on the Status icon  at any time. When you right click on the 
Status icon, the following side menu displays:

The four menu entries at the bottom correspond to the four configuration settings tabs: the Status, Config, Advanced, and About 
respectively. This side menu provides a shortcut to the configuration settings.

Wireless Radio On Turns on the radio. LED is on and the Link Icon displays with signal strength.

Wireless Radio Off Turns off the radio. A pop-up window will ask for your confirmation. If confirmed, the LED will be off 
and the Link Icon will change color from green to red on the top without signal strength displayed. The 
WLAN card/module will stop functioning. 

Remove Status Icon Removes the Status Icon from the Windows Status Tray. A pop-up window will ask for your 
confirmation. If confirmed, the Status (Link) Icon will be removed from the Windows Status Tray.

Wireless Network Status Opens the Status tab of the configuration utility

If the Status Icon changes to a crossed lock , it warns you that you may have entered a wrong key (WEP Key mismatch) for 
the WEP-On AP or a station.

Remove Wireless Status Icon Window
If you choose to remove the Remove Status Icon, the screen shown below displays: 

Press Yes to confirm, or No to cancel. 

If confirmed, the Status Icon will not display in the Windows Status Tray. By checking “Remove Status Icon Permanently” at the 
bottom of the window you will not see the Status Icon even after your system has been restarted. Otherwise it will re-appear next 
time you turn on the system. 

Double clicking on the Pegasus Configuration Icon from the Control Panel will always bring the Status (Link) Icon back to the 
Windows Status Tray for either temporary removal or permanent removal of the icon.
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Wireless Personal Area Network Communications with Bluetooth

Setting up Your Bluetooth Card
Note: Note: If you use the Get Connected! Wizard, which is recommended for normal usage, then this step is not necessary. 

This step would be used to change the friendly name of your mobile computer.

1 After you insert the Bluetooth Card, the Bluetooth icon  should appear in the task tray (visible from the Today screen for 
Pocket PCs). Tap on the icon.

Note: If you installed OBEX, the menu will also list Transfer via Bluetooth.

2 In the pop-up menu, select Advanced Features, then My Bluetooth Device.

3  In the My Bluetooth Device screen, you can modify the Friendly Name and make any desired configuration changes. 
When done, tap OK.

• In normal phone connect operation, Discoverable mode is not needed and should be disabled.
• If you do enable Discoverable mode (e.g., for ActiveSync), note that it does not shut off by itself. To save power, remember 

to disable it when not needed. 
• Connectable, Use Authentication, and Use Encryption are also not required for printing or dial-up networking applications.
• Check Use Authentication to enable the Use Encryption option.

Assign COM Ports
Follow these steps to view and/or modify the Bluetooth COM ports. 
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1 Tap on the Bluetooth icon on the Today screen. Select Advanced Features then My Bluetooth Device.

Note: If you installed OBEX, the menu will also list Transfer via Bluetooth.

2 The My Bluetooth Device screen will appear. Tap on the COM Ports tab.

3  As needed, view and/or enable/disable the Bluetooth COM port assignments. Tap OK. 

Note: The Bluetooth Phone port cannot be disabled.

Discover Bluetooth Device(s)
Follow these steps to discover other Bluetooth devices nearby, including non-phone devices. The Device Discovery Wizard is a 
more detailed alternative to using the Bluetooth “Get Connected!” Wizard or Bluetooth ActiveSync or Bluetooth LAN Access 
options. The Device Discovery Wizard allows you to discover any type of Bluetooth device.

1 If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced 
Features then Bluetooth Devices.

2 In the Bluetooth Devices Folder, tap on the Device Discovery icon. Or you can tap on Tools. In the pop-up menu, select 
Device Discovery.
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 5 - 15



Chapter 5 - Wireless Communications with Dolphin 9500/9550 Bond with Discovered Device(s)
3 Follow the Bluetooth Device Discovery Wizard to search for Bluetooth devices nearby. When prompted, select the device 
type you seek.

4  When the search is complete, a screen will report the discovered Bluetooth devices. Check the box next to any device you 
wish to save information about, (i.e., any devices you wish to connect to). Tap Next>.

5  A service discovery phase will begin, 5-10 seconds per chosen device.

6 In the next screen, tap Finish.

Bond with Discovered Device(s)
Follow these steps to bond with an already discovered Bluetooth device. In most cases, bonding is for establishing secure 
communications with a Bluetooth-enabled phone. This is a more detailed alternative to using the Bluetooth “Get Connected! 
Wizard.”

Important!

• Do not try to bond with a Motorola Timeport 270C or Nokia 6310!
• Do not use this method to bond with a printer! The third-party printing software included on the installation CD also handles 

bonding.
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1 If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon in the Today screen. Select Advanced 
Features, then Bluetooth Devices.

2 Tap and hold your stylus on the Bluetooth device you want to bond with. In the pop-up menu, select Bond.

3 Alternatively, after selecting a device, tap on the Bond icon. Or tap on Device, then select Bond.

4 The Bluetooth Device Bonding Wizard will launch. Follow the wizard to bond with your selected device. 
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5 As prompted, make sure the Bluetooth device that you want to bond with is in Bondable mode.

6 If the remote device is set up to accept bonding, a Bluetooth Passkey screen will appear. To continue bonding, enter the 
correct passkey and tap Reply.

7 When you have successfully bonded with the other device, tap Finish.

View Device Properties
Follow these steps to view the properties of an already discovered device. 

1 If not open, launch the Bluetooth Devices folder. Tap on the Bluetooth icon on the Today screen. Select Advanced 
Features then Bluetooth Devices.

2 Select a device. Tap on the Properties icon, or tap on Device then select Properties. Alternatively, you can tap and hold 
your stylus on the Bluetooth device you want to view information about. In the pop-up menu, select Properties.
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3  Use the General and Services screens to research device properties. If needed, assign a new device type icon by tapping 
on the arrow buttons in the General screen. You can also use the Device name field to rename the device. When done, tap 
ok for the setting to take effect.

Set up Your Favorite Device
Follow these steps to set up default devices in the Bluetooth Devices folder. 

Note:  The Get Connected! Wizard automatically assigns the favorite phone.

Complete these steps:

1 Tap on Tools and select My Favorites. 

2 Tap on the tab for the type of device you would like to set a favorite for. If needed, use the arrow buttons to scroll and find the 
tab you need.

Note: Tabs will appear only for COM ports you have enabled. To enable a port, refer to the “Assign COM Ports” section earlier 
in this chapter.

3 To select a favorite device, select Use the favorite selected above. In the drop-down menu, select your device. Tap OK.

4 After setting a device as your favorite, its icon will appear in the Bluetooth Devices folder with a heart next to it.

Change Views
You can switch between the Large Icons or Details views for the Bluetooth Devices folder.
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1 In Bluetooth Devices, tap on View.

2 In the pop-up menu, choose between Large Icons or Details.

Note: In Details view, scroll right to see the current Bonded status.

Large Icons view

Details view
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Delete a Device from the Folder
If you no longer plan to connect with it, you can delete a device from the Bluetooth Devices folder. 

1 If not open, launch the Bluetooth Devices folder.

2 Tap and hold your stylus on the device you wish to delete. In the pop-up menu, select Delete.

3 Alternatively, after selecting a device, tap on the Delete icon. Or tap on Device then select Delete.

4 A Confirm screen will appear. Tap Yes.
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Turn Radio Transmitter ON/OFF

You may want to turn off the radio transmitter to save power or if you are entering an area with radio restrictions (e.g., an airplane).

1 The Bluetooth icon  should appear in the task tray on the Today screen. Tap on the icon.

2 In the pop-up menu, select Turn Transmitter OFF.

3 The Bluetooth Card radio transmitter will shut off. The Bluetooth icon in the task tray will become gray, as will relevant menu 
options (e.g., Get Connected!).

4 To turn the radio transmitter back on, tap on the gray Bluetooth icon. In the pop-up-menu, select Turn Transmitter ON.

Bluetooth ActiveSync
This section explains how to use the Bluetooth ActiveSync feature. It helps you quickly and easily ActiveSync to a notebook or 
desktop computer with ActiveSync v3.x installed.

1 Tap on the Bluetooth icon . In the pop-up menu, select Bluetooth ActiveSync.

2 The next screens will vary depending on if your Bluetooth Devices folder contains any computers, and if one is chosen as 
your favorite. Please refer to the appropriate scenario:

SCENARIO #1: Your Bluetooth Devices folder contains a favorite desktop computer.
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(a) When you tap Bluetooth ActiveSync, your mobile computer will automatically try to connect to your favorite computer. 

(b) The Connect To screen will appear, reporting that it is trying to connect to Wireless ActiveSync.

(c) After a successful connection is made, the status screen will report Connected. Now you are ready to synchronize files, if 
desired.

SCENARIO #2: Your Bluetooth Devices folder contains no favorite desktop computer.

(a) When you tap on Bluetooth ActiveSync, a screen will appear that allows you to choose which computer to connect to in 
your Bluetooth Devices folder. Choose a computer from the list and tap Select, or tap Find to search for another computer.

Note: If the computer you want to connect to is not listed, tap Find to begin a search. Proceed as described in Scenario #3 on 
the next page.

(b) Your mobile computer will attempt to connect to your selected  computer.

(c) After a successful connection is made, the status screen will report Connected. Now you are ready to synchronize files, if 
desired.

SCENARIO #3: Your Bluetooth Devices folder contains no computers.
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(a) When you tap on Bluetooth ActiveSync, a Bluetooth Device Search will automatically begin.

Note: You can also start the device search by tapping Find in the Bluetooth Devices screen. See Scenario #2 on page 5-23.

(b) After the search is complete, select the computer you wish to ActiveSync with and tap Select. If the computer is not listed, 
make sure the computer id discoverable and tap Refresh to search again.

(c) After you tap Select, a service discovery phase will begin.

(d) The Connect To screen will appear, reporting that it is trying to connect to Wireless ActiveSync.

(e) After a successful connection is made, the status screen will report Connected. Now you are ready to synchronize, if 
desired.

Bluetooth LAN Access
This section explains how to use the Bluetooth LAN Access feature to quickly and easily connect to a Bluetooth-enabled LAN 
access point.

1 Tap on the Bluetooth icon. In the pop-up menu, select Bluetooth LAN Access.

2 The next screens will vary depending on if your Bluetooth Devices folder contains any access points, and if one is chosen as 
your favorite. Please refer to the appropriate scenario:

SCENARIO #1: Your Bluetooth Devices folder contains no favorite access point.
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(a) When you tap Bluetooth LAN Access, a screen will appear that allows you to choose which access point to connect to in 
your Bluetooth Devices folder. Choose an access point from the list and tap Select. 

Note: If your access point is not listed, tap Find and proceed as described in Scenario #3.

(b) Your mobile computer will try to connect to the selected access point.

(c) If your LAN requires a passkey, a screen will appear, asking for the passkey. Enter the passkey, then tap ok.

(d) After a successful connection is made, the status screen will report Connected.

(e) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #2: Your Bluetooth Devices folder contains a favorite access point.

(a) When you tap Bluetooth LAN Access, your mobile computer will automatically try to connect with your favorite access point.

(b) If your LAN requires a passkey, a screen will appear, asking for the passkey. Enter the passkey, then tap ok.
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(c) After a successful connection is made, the status screen will report Connected.

(d) Now you are ready to access your LAN for Internet access, files, etc.

SCENARIO #3: Your Bluetooth Devices folder has no access points. 

(a) When you tap Bluetooth LAN Access, the mobile computer will automatically begin to search for new Bluetooth devices.

Note: You can also start the device search by tapping Find in the Bluetooth Devices screen. See Scenario #2 on page 5-23.

(b) After the search is complete, select the access point you wish to connect to. Tap Select. If the access point is not listed, tap 
Refresh to search again.

(c) After you tap Select, a service discovery phase will begin.

(d) If the LAN requires a Passkey, a screen will appear, asking for the Passkey. Enter the passkey, then tap ok.

(e) After a successful connection is made, the screen will report Connected.
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(f) Now you are ready to access your LAN for Internet access, files, etc.

Bluetooth Printing
This chapter explains how to print from a Bluetooth-enabled printer using the PrintPocketCE software included on the installation 
CD to print from your device. 

You can print using the PrintPocketCE program included on the Bluetooth Card Installation CD. The Bluetooth Connection Kit 
includes a 30-day trial version of PrintPocketCE. For a full version, please visit: www.fieldsoftware.com

If you have not done so already, be sure to install the PrintPocketCE program. To find the install for this program on the 
installation CD, go to the Third Party folder, then the Field Software folder.

1 Start the printing program. Go to Start>Programs>PrintPocketCE.

2 In the welcome screen, tap OK.

3 In the main screen, tap on the file you wish to print. 

To locate your file:
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• Tap on the Word icon at the bottom of the screen to view a list of Pocket Word docs, TXT, or RTF files. 
• Tap on the Excel icon to view a list of Pocket Excel files
• Tap on the yellow envelope icon to view e-mail messages.
• Tap on the Doc/Excel/Email Options menu and select another type of printing (e.g., Go to email printing).
• Use the folders drop-down menu to switch between folders.

4 The next screens let you adjust the printer settings. Make sure the correct printer is chosen. For Port, choose Bluetooth: CF 
Card. Make any other necessary printer settings. 

Note: For a Pocket Excel file, the first screen lets you adjust printing properties. Tap Continue to select the correct printer and 
port. Instead of Bluetooth: CF Card, you can choose the COM port assigned to your Bluetooth printer.

If needed, tap on More Settings to adjust margins, form feed, and other settings. Tap OK to return to the main printing screen.

When done adjusting the settings, tap Start Printing.
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5 The mobile computer will search for a Bluetooth printer. After the search, the Bluetooth Devices folder will appear. Select the 
Bluetooth printer, then tap Select.

If the mobile computer fails to detect the Bluetooth printer, make sure the printer is on, discoverable, and in range. Tap Find to 
repeat the search.

6 The document will begin printing.

7 To exit the program, tap Doc Options. In the pop-up menu, tap Exit.

OBEX

This section explains how to use the OBEX (object exchange) application to trade business cards, contacts or files with another 
Bluetooth device that supports OBEX.

Bluetooth OBEX application supports five operations:

• Exchange Business Cards
• Send a Contact
• Send a File
• Browse Remote Device
• Receive Contact or File
• Enable File Sharing

The first four operations - exchange business cards, send a contact, send a file, and browse remote device - are client-oriented. 
They involve initiating an object exchange.

The last two operations - receive contact or file and enable file sharing - are server-oriented. They involve accepting objects in 
an exchange initiated by another Bluetooth device.

Important! 

If you have not done so already, be sure to run the OBEX Installer from the Bluetooth Card Installation CD. Otherwise, 
you will not be able to perform any OBEX operations with the Bluetooth Card.

After you install OBEX, the Transfer via Bluetooth option will appear in the Bluetooth menu for you to select OBEX 
operations.
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Exchange Business Cards

1 Make sure both Bluetooth devices have a business card assigned to them.

Note: If each device does not have a business card assigned to it, you will not be able to exchange business cards.

To assign a business card to your mobile computer, do the following:

• Tap on the Bluetooth icon. In the pop-up menu, tap Advanced Features | My Bluetooth Device.
• Tap on the Object Sharing tab. Under My business card, tap Assign…

• ·In the next screen, select your business card and tap ok. If your business card is not listed, tap on the Contacts button to 
create one.

 

· When you return to the Object Sharing screen, tap ok.

2 Make sure the other Bluetooth device is set up to receive a contact. The device must support the OBEX Object Push profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

3 Now you are ready to exchange business cards. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | 
Exchange Business Cards.
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4 If your mobile computer has no devices in the Bluetooth Devices Folder, then it will begin to search for Bluetooth devices 
nearby.

5 Select the Bluetooth device you wish to exchange business cards with. If the device is not listed, tap Find.

6 Your mobile computer will begin to exchange business cards. After the exchange, the new business card should appear in 
your Contacts list.

 

Send a Contact

1 Make sure the other Bluetooth device is set up to receive a contact. It must support the OBEX Object Push server profile. 
Refer to the documentation that came with the device for instructions.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a contact by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2 Now you are ready to send a contact. Go to your Contacts folder.
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3 Tap and hold your stylus on the contact(s) you would like to send. In the pop-up menu, select Send Via Bluetooth.

4 If your mobile computer has no devices in the Bluetooth Devices Folder, then it will begin to search for Bluetooth devices 
nearby.

5 Select the Bluetooth device you wish to send the contact(s) to. If the desired device is not listed, tap Find.

6 Your mobile computer will process and send the contact(s).
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Send a File

1 Make sure the other Bluetooth device is set up to receive a file. It must support the OBEX Object Push server profile. Refer to 
the documentation that came with the device for instructions.

Note: If the other device is also using the Bluetooth Connection Kit, you can set it up to receive a file by tapping the Bluetooth 
icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2 Now you are ready to send a file. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | Send a File.

3 If your mobile computer has no devices in the Bluetooth Devices Folder, then it will begin to search for Bluetooth devices 
nearby.

4 Select the Bluetooth device you wish to send a file. If the desired device is not listed, tap Find.
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5 In the next screen, tap on the file you wish to send. You can use the Folder and Type drop-down menus to search for your 
file. Also, you can scroll horizontally to view the folder, date, size, type, and location of each file.

6 Your mobile computer will send the file.

Browse Remote Device
The Bluetooth File Explorer lets your mobile computer share files with another Bluetooth device. The other device must support 
the OBEX File Transfer server profile.

This section covers the following file transfer operations:

• Prepare for file transfer
• Send/receive file(s) or folder(s)
• Create a folder
• Delete file(s) or folder(s)
• Refresh remote view
• Connect/disconnect
• Exit the program

Note: “Local device” refers to the mobile computer you are running the OBEX from. “Remote device” refers to the Bluetooth 
device you are trying to transfer files with.

Prepare for File Transfer

1 Make sure the remote device has file sharing enabled. It must support the OBEX File Transfer server profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can enable file sharing by tapping the Bluetooth icon. 
In the pop-up menu, tap Transfer via Bluetooth | Enable File Sharing.
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2 Now you are ready to browse the remote device. Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | 
Browse Remote Device.

3 If your mobile computer has no devices in the Bluetooth Devices Folder that supports OBEX File Transfer, then it will begin to 
search for Bluetooth devices nearby.

4 Select the Bluetooth device you wish to browse. If the desired device is not listed, tap Find.

5 Your mobile computer will begin to establish a file sharing connection.
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 5 - 35



Chapter 5 - Wireless Communications with Dolphin 9500/9550 Browse Remote Device
6  After the devices successfully connect, the Bluetooth File Explorer will appear. Half of the screen shows contents of the 
remote device, while the other half shows contents of your device (the local device). The very bottom of the screen reports 
the connection status.

Send/Receive File(s) or Folder(s)

• Single-tap items to select them for transfer.
• Double-tap on a folders to open it and see its contents.

Complete these steps:

1 Select the file(s) or folder(s) that you wish to transfer. You can select items from only one device per transfer session.

2 There are two different ways to initiate the transfer:

• Tap on the File menu. Select Send to remote or Get from remote, as applicable. The inappropriate option should be 
gray.

• Tap on the Send to remote icon or Get from remote icon, as applicable. The inappropriate icon should be gray.
3 A screen will report the status of the transfer.

4 After the transfer, a copy of each selected item should appear in the other device.

Create a Folder
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1 Tap on the File menu. Select Remote device or Local device, wherever you want to create a folder, then tap Create remote 
folder or Create local folder, as applicable.

2 Alternatively, on the Dolphin 9500/9550, you can tap and hold your stylus on an item in either the remote or local device that 
you wish to put in a new folder. In the pop-up menu, select Create folder.

3 In the next screen, enter a name for your new folder. Tap OK.

4 The new folder should be listed under the appropriate device.

Delete File(s) or Folder(s)

1 Select item(s) that you wish to delete. You can only delete item(s) from one device at a time.

2 Tap on the File menu. Select Remote device or Local device, wherever the item(s) are located, then tap Delete remote 
item(s) or Delete local item(s), as applicable.

3 Tap and hold your stylus an item in either the remote or local device that you wish to put in a new folder. In the pop-up menu, 
select Delete folder.

4 In the Confirm screen, tap Yes.
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Refresh Remote View

1 Tap on the Device menu. Select Refresh remote view.

2 Your local device will begin to read the contents of the remote device.

3 After a few seconds, the view of the contents of the remote device will be refreshed.

Connect/Disconnect

To connect to the remote device, do the following:

1 Make sure the remote device has file sharing enabled.

2 Start the connection process by either of two methods:

• ·Tap on the Device menu. Select Connect.
• ·Tap on the Connect icon.

3 In the next screen, select the device you wish to connect to. Tap Select. Your mobile computer will attempt to connect to the 
device selected.

To disconnect from the remote device, do the following:

1 Start the disconnection process by either of two methods:

• Tap on the Device menu. Select Disconnect.
• Tap on the Connect icon.
2 Your mobile computer will disconnect from the remote device. Afterwards, no contents will be listed for the remote device.

Exit Bluetooth File Explorer

To exit the Bluetooth File Explorer, tap File | Exit. 
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 Receive Contact or File

1 Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2 The Receive Contact or File status screen will appear. Your mobile computer will wait two minutes for the contact or file.

3 After successfully connecting to the remote device, the screen will report Connected then disappear. The new contact or file 
should now be on your device.

4 If two minutes passes before you receive the item, tap Wait Again.

5 After you receive the file or contact, the “Receive Contact or File” feature is automatically disabled.

Enable File Sharing

1 Tap on the Bluetooth icon. In the pop-up menu, tap Transfer via Bluetooth | Enable File Sharing.

2 The Enable File Sharing status screen will appear. Your mobile computer will wait two minutes for the remote device to 
connect.

3 After successfully connecting to the remote device, the screen will report Connected.

4 If two minutes passes before you connect, tap Wait Again.

5 File sharing will be enabled until you end it by tapping Cancel.

The Dialer
This section explains how to assign a dialing prefix and use the Dialer to dial a number directly from your Contacts list. The Dialer 
makes it quick and easy to perform dial-up networking.
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If you have not done so already, be sure to run the Dialer Installer from the Bluetooth Card Installation CD. While installing the 
program, you can also assign the dialing prefix.

Note: The Dialer has been verified to work with Nokia and Ericcson phones and is known not to work with the Motorola 270c, 
NTT Docomo Paldio 633S or Sony au C413S phone. Results may vary with other phones that are not listed as being supported 
by the Bluetooth system.

Assign a Dialing Prefix

If you have not already assigned a dialing prefix during the install process, you can do so by following these steps:

1 Go to Start | Settings | System. Tap on Dialer.

2 Select the appropriate Dialing Prefix, then tap ok.

Use the Dialer

1 To use the dialer, the mobile computer must already be connected to the Bluetooth phone. You can use the Get Connected! 
Wizard to do this. Also, the Bluetooth phone must be selected as your favorite.

2 Go to Start | Contacts.

3 Tap and hold your stylus on the contact you wish to dial to. In the pop-up menu, select Dial Contact. Alternatively, you can 
tap on Tools and select Dial Contact.

4 If you have multiple phone numbers for a contact, a screen will appear listing them, including any dialing prefix you may have 
assigned. Select the phone number you wish to dial.
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 5 - 40



Chapter 5 - Wireless Communications with Dolphin 9500/9550 Get Connected Wizard
5 Your mobile computer will connect to your phone and begin dialing.

Note: The Dialer can dial a phone number containing any of the 17 following non-numeric characters:

* # + . / ! @ - \ space    A    B    C     D     T      P     W

Additionally, the following string can be included in a phone number: 

                                                                           (',')

The Dialer can not dial a phone number containing non-numeric characters other than those listed above.

HHP recommends that you follow the standard Microsoft Outlook format for phone numbers.

Get Connected Wizard
The Get Connected! Wizard guides you through a one-time setup process that prepares the mobile computer and phone for 
Bluetooth connections. The wizard varies depending on what phone you want to connect to.

Ericsson, Nokia 6210, NTT DoCoMo, Sony Phones 

1 Tap on the Bluetooth task tray icon. In the pop-up menu, select Get Connected!

2 Follow the Bluetooth “Get Connected!” Wizard. In the second screen, use the drop-down list to select your Bluetooth phone. 
The wizard will provide tailored instructions based on your selection.
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3 Follow the next screen(s) to prepare your specific phone for Bluetooth connections. You may need to do 1, 2 or all of the 
following steps:

a. Naming your Bluetooth phone

b. Setting your Bluetooth phone in Discoverable mode

c. Preparing your Bluetooth passkey.

 

4 When the search is complete, a list of the discovered Bluetooth phones will appear. Choose the phone you wish to connect 
to, and tap Select. A service discovery phase will begin, about 5-10 seconds.

5 As prompted in the next screen, prepare your phone for bonding. For instructions on setting your phone to “Bondable” or 
“Pairable” mode, refer to your phone manual. Have your passkey ready, then tap Next>.
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6 In the next screen, enter the passkey. Tap Reply.

 

7 The mobile phone may then either automatically accept the passkey or ask you to enter one. If prompted for a passkey, use 
the same one you entered on the mobile computer.

Ericsson T68/T68i only: When the phone asks you if you want to bond, select 2: Add to paired devices. Do not tap ACCEPT.

8 Tap Finish. After successfully connecting, the phone will appear in the Bluetooth Devices folder. In the Today screen, the 
Bluetooth icon will also blink. You will not need to run the Get Connected! Wizard again unless you plan to switch between 
different phones.

Note: You may also switch between different phones by assigning a new “favorite phone” in the Bluetooth Devices folder.

Motorola Timeport 270C, Nokia 3650/6310/7650/8910/8910i 

1 Tap on the Bluetooth task tray icon . In the pop-up menu, select Get Connected!

2 Follow the Bluetooth “Get Connected!” Wizard. In the second screen, use the drop-down list to select your Bluetooth phone. 
The wizard will provide tailored instructions for your phone.

Note: The screens below are for the Nokia 7650.

3 As directed in the next two screens, assign the phone a unique name and set the phone in Discoverable mode. Then tap 
Next>.

4 The mobile computer will begin to search for the phone. When the search is over, a list of the discovered Bluetooth phones 
will appear.

Choose the phone you wish to connect to, and tap Select. A service discovery phase will begin, about 5-10 seconds.
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5 The next two screens describe procedures you can only complete outside of the wizard. Read through each screen but do 
not complete the described procedures until you exit the wizard. Directions for these procedures are provided in STEP 7: 
Dial-up to Your Network, starting on the next page. The two procedures are:

Bonding with your phone - This must be completed in order to complete the Bluetooth connection and involves dial-up 
networking.

 

Automatic Connections - This procedure is optional but will make future Bluetooth connections more convenient. 

6 Continue to the last screen of the wizard and tap Finish. Now proceed to STEP 6 to complete the bonding process and, if 
desired, set up automatic connections.

 

Dial-up to Your Network
Complete the following steps to create a new Bluetooth connection. Before setting up dial-up networking, prepare yourself with 
dial-up information and other necessary settings for your office network or ISP. 
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1 Go to Start | Settings | Connections. Tap on the Connections icon. In the top field, select Internet Settings. Tap Modify… In 
the next screen, tap New…

2 In the next screen, enter a name for the dial-up connection. For the modem, select Bluetooth Phone. For the Baud Rate, 
select 115200. Tap Advanced… 

Note: Remember what you name the connection. You will need it when you start the connection.

3 The Port Settings screen will appear. If needed, tap on the TCP/IP and/or Name Servers screens to enter any necessary 
settings for your office network or ISP. Tap ok. 

4 Tap Next.

5 In the Phone number field, enter the dial-up number. Tap Next.
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6 Uncheck Wait for dial tone before dialing. Tap Finish.

7 Now you are ready to start the connection. In the Connections screen, under Internet Settings, tap Connect. In Network Log 
On, verify the dialing settings. Tap OK.

8 ONLY FOR MOTOROLA TIMEPORT 270C OR NOKIA 3650/6310/7650/8910/8910i: 

a) After you tap Connect for the first time, the phone will display a message asking if you want to bond. On Motorola, enter 
GRANT; on Nokia, enter ACCEPT. 

b) Make up a 4-16 digit passkey, enter it on the phone, then enter it on the Dolphin 9500/9550.

Note: The Bluetooth icon on the Today screen will blink to indicate a connection.

c) After successfully bonding, you can set up the phone to automatically connect to your Dolphin 9500/9550 without requiring a 
passkey.

Automatic Connections for Motorola Timeport 270C:

• On the phone, press MENU.
• Scroll to Settings, then press SELECT.
• Scroll to Connection, then press ON.
• On Bluetooth Link, press SELECT.
• Scroll to Devices, then press SELECT.
• Choose your mobile computer, then press EDIT.
• Scroll to Access:Ask, then press CHANGE.
• Scroll to Automatic, then press SELECT. Press DONE.
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Automatic Connections for Nokia 3650/7650:

• On the phone, press MENU.
• Scroll to Connectivity, then press Options.
• The Open option should be highlighted. Press Select.
• The Bluetooth option should be highlighted. Press Options.
• The Open option should be highlighted. Press Select.
• Scroll to the right tab to access the Paired devices list. Highlight your mobile computer, then press Options.
• Scroll to Set as authorized, then press Select.
• In the confirmation screen, press Yes.

Automatic Connections for Nokia 6310/8910/8910i:

• On the phone, press MENU.
• Scroll to 10 Bluetooth, then press SELECT.
• Scroll to 4 View Paired Devices, then press SELECT.
• Highlight the Dolphin 9500/9550, then press OPTIONS.
• Scroll to 3 Request Connection Authorization, then press NO.

To use a different Bluetooth phone for dial-up networking, you can use the same connection setup, but you must make the new 
phone your favorite. Just run the Get Connected! Wizard again, select the new phone, and make it your new Favorite when 
prompted. 

Alternatively, you can use the Bluetooth Devices folder to change your favorite phone. Refer to Using the Dolphin 9500/9550 
Mobile Computer beginning on page 4-1 for instructions.
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Chapter 6 - Customizing Your Dolphin 9500/9550
You can customize your Dolphin 9500/9550 by 

• adjusting device settings and 
• installing additional software.

Adjusting Device Settings

You can adjust device settings to suit the way you work. To see available options, tap Start > Settings > Personal or System 
tab located at the bottom of the screen.

You might want to adjust the following:

Clock to change the time or to set alarms

Menus to customize what appears on the Start menu, and to enable a pop-up menu from the New button

Owner Information to enter your contact information

Password to limit access to your device

Power to maximize battery life

Today to customize the look and the information that is displayed on the Today screen
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Installing additional software

Programs added to your device at the factory are stored in FLASH. You cannot remove this software, and you’ll never 
accidentally lose FLASH contents. FLASH programs can be updated using special installation programs with a *.xip extension. 
All other programs and data files added to your device after factory installation are stored in RAM (random access memory). 

You can install any program created for your device, as long as your device has enough memory. The most popular place to find 
software for your device is on the Pocket PC Web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync
You’ll need to install the appropriate software for your device on your desktop computer before installing it on your device.

1 Determine your device and processor type so that you know which version of the software to install. Tap Start > Settings > 
System tab > About. The Version tab appears displaying the current information.

2 On the Version tab, make a note of the information in the Processor section. 

3 Download the program to your desktop computer (or insert the CD or disk that contains the program into your desktop 
computer). You may see a single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device 
types and processors. Be sure to select the program designed for the Pocket PC and your device processor type.

4 Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

5 Connect your device and desktop computer.

6 Double-click the *.exe file.

If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the software has been installed 
on your desktop computer, the installer will automatically transfer the software to your device. 

If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a different type 
of computer. You will need to move this file to your device. If you cannot find any installation instructions for the program in the 
Read Me file or documentation, use ActiveSync Explore to copy the program file to the Program Files folder on your device. For 
more information on copying files using ActiveSync, see ActiveSync Help. 

Once installation is complete, tap Start, Programs, and then the program icon to switch to it.

To add a program directly from the Internet

1 Determine your device and processor type so that you know which version of the software to install. Tap Start and then 
Settings. On the System tab, tap About. In the Version tab, make a note of the information in Processor. 

2 Download the program to your device straight from the Internet using Pocket Internet Explorer. You may see a single *.xip, 
*.exe or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to select the 
program designed for the Pocket PC and your device processor type.

3 Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

4 Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the directions on the screen.

Adding a Program to the Start Menu
Tap Start >  Settings > Menus >  Start Menu tab. Tap the check box for the program you want to add. 

If you do not see the program listed, you can either use File Explorer on the device to move the program to the Start Menu folder, 
or use ActiveSync on the desktop computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

Note: We recommend that you copy and paste special so that you do not alter your program configurations by accident.

1 Tap Start > Programs > File Explorer, and locate the program (tap the folder list, labeled My Documents by default, and 
then My Device to see a list of all folders on the device). 

2 Tap and hold the program and tap Cut on the pop-up menu. 

3 Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the window, and tap Paste on the 
pop-up menu. 
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4 The program should now appear on the Start menu.

Using ActiveSync on the desktop computer: Use the Explorer in ActiveSync to explore your device files and locate the 
program. Right-click the program, and then click Create Shortcut. Move the shortcut to the Start Menu folder in the Windows 
folder. The shortcut now appears on the Start menu. For more information, see ActiveSync Help.

Removing Programs
Tap Start > Settings > System tab > Remove Programs.

If the program does not appear in the list of installed programs, use File Explorer on your device to locate the program, tap and 
hold the program, and then tap Delete on the pop-up menu.
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Chapter 7 - Applications
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or 
together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox. 

Using Microsoft ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your desktop 
computer with your device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you 
synchronize, ActiveSync compares the changes you made on your device and desktop computer or server and updates both 
computers with the latest information. For information on using ActiveSync, see ActiveSync Help on the desktop computer.

You can switch to any of these programs by tapping them on the Start menu.
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Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your appointments in one of 
several views (Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu.

Note: You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools 
menu. 

To create an appointment:

1 If you are in Day or Week view, tap the desired date and time for the appointment.

2 Tap New.

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.

Calendar Application
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3 Using the input panel, enter a description and a location. Tap first to select the field. 

4 If needed, tap the date and time to change them.

5 Enter other desired information. You will need to hide the input panel to see all available fields.

6 To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 7-11.

7 When finished, tap OK to return to the calendar. 

Note: If you select Remind me in an appointment, your device will remind you according to the options set in Start, Settings, 
Personal tab, Sounds & Reminders. 

Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap Edit.

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

Entering an Appointment
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Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will be created 
automatically and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want 
meeting requests sent by tapping Tools and then Options. If you send and receive e-mail messages through ActiveSync, select 
ActiveSync.

To schedule a meeting:

1 Create an appointment.

2 In the appointment details, hide the input panel, and then tap Attendees.

3 From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees. 

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on the device.

View appointment details.

View.

Tap to change
appointment.

Appointment Summary Screen
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Contacts

Contacts maintains a list of your friends and colleagues so that you can easily find the information you’re looking for, whether 
you’re at home or on the road. Using the device infrared (IR) port, you can quickly share Contacts information with other device 
users.

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.

Contact Application
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To create a contact:

1 Tap New.

2 Using the input panel, enter a name and other contact information. You will need to scroll down to see all available fields.

3 To assign the contact to a category, scroll to and tap Categories and select a category from the list. In the contact list, you 
can display contacts by category.

4 To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 7-11.

5 When finished, tap OK to return to the contact list.

There are four ways to find a contact: 

• In the contact list, enter a contact name in the box under the navigation bar. To show all contacts again, clear text from the 
box or tap the button to the right of the box. 

• In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you want displayed. 
To show all contacts again, select All Contacts. To view a contact not assigned to a category, select None. 

• To view the names of companies your contacts work for, in the contact list, tap View > By Company. The number of contacts 
that work for that company will be displayed to the right of the company name. 

• Tap , Find, enter the contact name, select Contacts for the type, and then tap Go. 

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed. To change the contact information, tap Edit.

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

Creating a Contact
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View contact details.

Tap to view notes.

Tap to change contact information.

Contacts Summary Screen
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Tasks

Use Tasks to keep track of what you have to do. 

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Task Application
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 7 - 8



Chapter 7 - Applications Tasks
To create a task:

1 Tap New.

2 Using the input panel, enter a description.

3 You can enter a start date and due date or enter other information by first tapping the field. If the input panel is open, you will 
need to hide it to see all available fields.

4 To assign the task to a category, tap Categories and select a category from the list. In the task list, you can display tasks by 
category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 7-11.

6 When finished, tap OK to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap here to add a new task 
and enter your task information.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

Creating a Task
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.

Task Summary Screen
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 7 - 10



Chapter 7 - Applications Notes
Notes

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can create a written note or a 
recording. You can also include a recording in a note. If a note is open when you create the recording, it will be included in the 
note as an icon. If the note list is displayed, it will be created as a stand-alone recording.

To create a note:

1 Tap New.

2 Create your note by writing, drawing, typing, and recording. For more information about using the input panel, writing and 
drawing on the screen, and creating recordings, see Using the Dolphin 9500/9550 Mobile Computer beginning on page 4-1.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

Notes Application
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Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.

Creating a Note
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Inbox

Use Inbox to send and receive e-mail messages in either of these ways: 

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox 
synchronization in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the desktop 
computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox 
on your device. By default, you will receive messages from the past three days only, the first 100 lines of each message, and 
file attachments of less than 100 KB in size.

• E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those 
programs.

• E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in order to be transferred.

Note: You can also synchronize e-mail messages with your desktop computer from a remote location. For more information, 
see Chapter 7.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by 
connecting to an e-mail server.

When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. 
When you delete a message on your device, it is also deleted from the e-mail server the next time you connect based on the 
settings you selected in ActiveSync.

You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. 
Messages are sent as soon as you tap Send, which saves space on your device.

When working offline, once you’ve downloaded new message headers or partial messages, you can disconnect from the e-mail 
server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete 
messages you’ve marked for retrieval and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received messages are displayed first in 
the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

InBox Application
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When you connect to your e-mail server or synchronize with your desktop computer, by default, you’ll receive messages from 
the last five days only, the first 100 lines of each new message, and file attachments of less than 100 KB in size. The original 
messages remain on the e-mail server or your desktop computer. 

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the 
message list, tap and hold the message you want to retrieve. On the pop-up menu, tap Mark for Download. The icons in the 
Inbox message list give you visual indications of message status.

You specify your downloading preferences when you set up the service or select your synchronization options. You can change 
them at any time:

• Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your device. Tap Tools and then tap Options. On the Service 

tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.

Viewing A Message
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Composing Messages

To compose a message:

1 Tap New. 

2 In the To field, enter an e-mail or SMS address of one or more recipients, separating them with a semicolon, or select a name 
from the contact list by tapping the Address Book button. 
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

• Compose your message. To enter preset or frequently used messages, tap My Text and select a message.
• Tap Send when you’ve finished the message. If you are working offline, the message is moved to the Outbox folder and will 

be sent the next time you connect.

If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text 
message delivery notification before sending the message.

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.

Creating a Message
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Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox, 
and Sent Items. The Deleted Items folder contains messages that have been deleted on the device. The behavior of the Deleted 
and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On the 
Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders. To move 
a message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4. 

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your device. 
You can select to synchronize additional folders by designating them for ActiveSync. The folders you create and the 
messages you move will then be mirrored on the server. For example, if you move two messages from the Inbox folder to a 
folder named Family, and you have designated Family for synchronization, the server creates a copy of the Family folder and 
copies the messages into that folder. You can then read the messages while away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder. 
• If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

device and their copies on the mail server. The next time you connect, the mail server will see that the messages are missing 
from the device Inbox and delete them from the server. This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to folders created from anywhere except the 
device. 

• If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the server. Therefore, messages 
are available to you anytime you connect to your mail server, whether it is from your device or desktop computer. This 
synchronization of folders occurs whenever you connect to your mail server, create new folders, or rename/delete folders 
when connected. 
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Chapter 8 - Synchronizing Your Dolphin 9500/9550 
Terminal

Overview

Using Microsoft ActiveSync, you can synchronize information on your desktop computer with your device and vice versa. 
Synchronization compares the data on your Dolphin mobile computer with your desktop computer and updates both with the 
most recent data. 

For example, you can:

• Update the information in Pocket Outlook on your device by synchronizing it with Microsoft Outlook on your desktop computer. 
• Synchronize Microsoft Word and Microsoft Excel files between your device and desktop computer. Your files are automatically 

converted to the correct format.

Capabilities
With ActiveSync, you can also:

• Back up and restore your device data. 
• Copy (rather than synchronize) files between your device and desktop computer.
• Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually 

while connected to your desktop computer or only when you choose the synchronize command.
• Select which information types are synchronized and control how much data is synchronized. For example, you can choose 

how many weeks of past appointments you want synchronized.\

Note: By default, ActiveSync does not automatically synchronize all types of information. Use ActiveSync Options to specify the 
types of information you want to synchronize. The synchronization process makes the data (in the information types you 
select) identical on both your desktop computer and your device.

Requirements
To synchronize, ActiveSync must be on both your desktop computer and your device. ActiveSync is already installed on your 
device. Therefore, before you begin, you must install ActiveSync on your desktop computer. The program is on the Pocket PC 
Companion CD.    

To install ActiveSync on your desktop computer, insert the Pocket PC Companion CD into the CD-ROM drive of your desktop 
computer. Click the yellow arrow, click Start Here, then follow the directions on your screen.
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Setting up your desktop computer

When installation of ActiveSync is complete on your desktop computer, the ActiveSync Setup Wizard helps you 

• connect your device to your desktop computer, 
• set up a partnership so you can synchronize information between your device and your desktop computer, and 
• customize your synchronization settings. 

Synchronizing from your desktop computer
Because ActiveSync is already installed on your device, your first synchronization process begins automatically when you finish 
setting up your desktop computer in the wizard. 

After your first synchronization, look at Calendar, Contacts, and Tasks on your device. Notice that the same information from 
Microsoft Outlook on your desktop computer is now on your device, and you didn’t have to type a word. Simply disconnect your 
device from your computer and you’re ready to go!

For more information about using ActiveSync on your desktop computer, open ActiveSync (on your desktop computer), then 
open ActiveSync Help.

Synchronizing from your device
You must have setup ActiveSync on your desktop computer and completed the first synchronization process before you initiate 
synchronization from your device.

To initiate synchronization from your device, tap Start, then ActiveSync to begin the process. 

Note: If you have a wireless LAN card, you can synchronize remotely from your device.

For more information about ActiveSync on your device, switch to ActiveSync, tap Start, then Help.

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.
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Chapter 9 - Getting Connected
You can exchange information between your Dolphin 9500/9550 and other mobile devices, a desktop computer, a network, or 
the Internet. You have the following connection options:

• Use the infrared (IR) port on your device to send and receive files between two devices.
• Connect to your Internet service provider (ISP). Once connected, you can send and receive e-mail messages by using Inbox 

and view Web or WAP pages by using Microsoft Pocket Internet Explorer. The communication software for creating an ISP 
connection is already installed on your device. Your service provider will provide software needed to install other services, 
such as paging and fax services.

• Connect to your desktop computer to synchronize remotely. Once connected, you can synchronize information such as your 
Pocket Outlook information. 

Get Help on Connecting
More information on the procedures described here, as well as information on additional procedures, can be found in the following 
locations:

• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.
• Online Help on the device. Tap Start and then Help. Tap View, All Installed Help, and then Inbox or Connections.
• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync Help on the Help menu.

For troubleshooting information, go to the Pocket PC Web site at: http://www.microsoft.com/mobile/pocketpc
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Transfer Items Using Infrared

Using infrared (IR), you can send and receive information, such as contacts and appointments, between two Windows-equipped 
devices.

Verify Beam Settings 

For IR receive to work automatically, the Beam Settings must be correct. 

To verify, tap Start > Settings > Connections tab > Beam. The following window should appear.   

If this box is not checked, select Start>Programs>Infrared Receive before receiving data from another device. The terminal 
searches for another device.

To send information

Assuming your Beam Settings are correct:

1 Open the program where you created the item you want to send and locate the item in the list.

This is the correct, 
default setting.
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2 Align the IR ports so that they are unobstructed and within a close range.

3 Tap and hold the item, then tap Beam Item on the pop-up menu.

Note: You can also send items, but not folders, from File Explorer. Tap and hold the item you want to send, and then tap Beam 
File on the pop-up menu.

To receive information:

1 Align the IR ports so that they are unobstructed and within a close range.

2 Have the owner of the other device send the information to you. Your device will automatically receive it.
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Chapter 10 - Pocket Internet Explorer 
Overview

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in either of these ways:

• During synchronization with your desktop computer, download your favorite links and mobile favorites that are stored in the 
Mobile Favorites subfolder in Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. 

When connected to an ISP or network, you can also download files and programs from the Internet or intranet.

Accessing Pocket Internet Explorer
To switch to Pocket Internet Explorer, tap Start and then Internet Explorer.

You can use Pocket Internet Explorer to browse Mobile Favorites and channels that have been downloaded to your device 
without connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse the 
Web.

To browse the Internet on your terminal

1 Set up a connection to your ISP or corporate network using Connections; see Getting Connected on page 9-1.

Note: If you select Pocket Internet Explorer before setting up the network connections, a screen may appear allowing you to 
proceed to the connection settings screen. After you select the settings, you return to Pocket Internet Explorer. To add a 
favorite link while using the device, go to the page you want to add, tap and hold on the page, and tap Add to Favorites.

2 To connect and start browsing, tap View and then Address Bar. 

3 In the address bar that appears at the top of the screen, enter the Web address you want to visit and then tap Go. 

4 Tap the arrow to choose from previously entered addresses.

If Mobile Favorites have been set up, you can click one of them to start browsing. See The Mobile Favorites Folder on page 10-2.
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The Mobile Favorites Folder

Purpose

The Mobile Favorites folder was created on your desktop computer when you installed ActiveSync. It enables you to create 
Favorite Links on your desktop computer that you can transfer to your Dolphin 9500/9550 terminal. Those Favorite Links are then 
available for selection when browsing the internet on your terminal. 

Process

First, you create your Favorite Links in the Mobile Favorites folder on your desktop computer. Then, the next time you sync your 
desktop computer with your terminal, those Mobile Favorites are transferred to the Mobile Favorites folder on to your terminal. 

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on your desktop computer are 
synchronized with the Mobile Favorites folder on your terminal. 

Note: Unless you mark a Favorite Link as a mobile favorite, only the link downloads to your terminal and you will need to connect 
to your ISP or network to view the content. For more information on synchronization, see ActiveSync Help on the desktop 
computer.

Creating and Synchronizing Mobile Favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download Mobile Favorites to your 
device. Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are 
disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites

Complete these steps:

1 On your desktop computer, open Internet Explorer, click Tools and then Create Mobile Favorite.

2 To change the link name, enter a new name in the Name box. 

3 Optionally, in Update, select a desired update schedule.

4 Click OK. Internet Explorer downloads the latest version of the page to your desktop computer.

5 If you want to download the pages that are linked to the mobile favorite you just created, in Internet Explorer on the desktop 
computer, right-click the mobile favorite and then click Properties. In the Download tab, specify the number of links deep 
you want to download. To conserve device memory, go only one level deep.

6 Synchronize your device and desktop computer. Mobile favorites that are stored in the Mobile Favorites folder in Internet 
Explorer are downloaded to your device.

If you did not specify an update schedule in Step 3, you will need to manually download content to keep the information updated 
on your desktop computer and device. Before synchronizing with your device, in Internet Explorer on your desktop computer, 
click Tools and then Synchronize. You will see the last time content was downloaded to the desktop computer, and you can 
manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on your desktop computer, 
click View, Toolbars, and then Customize.

To view mobile favorites and channels on the terminal

1 Access Pocket Internet Explorer.

2 Tap the Favorites button to display your list of favorites . 
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3 Tap the page you want to view. 

You’ll see the page that was downloaded the last time you synchronized with your desktop computer. If the page is not on your 
device, the favorite will be dimmed. You will need to synchronize with your desktop computer again to download the page to your 
device, or connect to the Internet to view the page.

Saving memory on your terminal

Mobile favorites take up storage memory on your device. 

To minimize the amount of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or stop some 
mobile favorites from being downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, right-click the mobile 
favorite you want to change and then Properties. On the Download tab, specify 0 or 1 for the number of linked pages 
you want to download.

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You 
subscribe to AvantGo channels directly from your device. Then, you synchronize your device and desktop computer, or connect 
to the Internet to download the content. For more information, visit the AvantGo Web site.

To sign up for AvantGo: 

1 In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo information type.

2 In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites .

3 Tap the AvantGo Channels link.

4 Tap the Activate button.

5 Follow the directions on the screen. You will need to synchronize your device with your desktop computer and then tap the 
My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove link.
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Chapter 11 - Companion Programs
Available companion programs

The companion programs for Pocket PC are

• Microsoft Pocket Word and 
• Microsoft Pocket Excel. 

Media Player, Microsoft ® Money, MSN Messenger, Microsoft Reader are NOT included on the Dolphin 9500/9550 but maybe 
installed from the Microsoft Companion CD.

Accessing companion programs

To switch to a companion program on your device, tap Start > Programs > then tap the program name.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to copies of your documents. You 
can create new documents on your device, or you can copy documents from your desktop computer to your device. Synchronize 
documents between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create a new file, tap Start> 
Programs>Pocket Word>New. A blank document appears. Or, if you’ve selected a template for new documents in the Options 
dialog box, that template appears with appropriate text and formatting already provided. You can open only one document at a 
time; when you open a second document, you’ll be asked to save the first. You can save a document you create or edit in a 
variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt). 

Using Pocket Word   
Pocket Word contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then, select the appropriate action on the pop-up menu.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.
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Chapter 11 - Companion Programs Typing Mode
You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording), which are displayed on 
the View menu. Each mode has its own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on the 
command bar.

You can change the zoom magnification by tapping View and then Zoom. Then select the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your document.

If you’re opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can 
see the entire document.

Typing Mode
Using the input panel, enter typed text into the document. For more information on entering typed text, refer to Using the Dolphin 
9500/9550 Mobile Computer.

To format existing text and to edit text, first select the text. You can select text as you do in a Word document, using your stylus 
instead of the mouse to drag through the text you want to select. You can search a document to find text by tapping Edit and then 
Find/Replace.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a guide, and the zoom magnification 
is greater than in typing mode to allow you to write more easily. 

For more information on writing and selecting writing, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1. 

Writing on the Screen in Pocket Word     

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as 
described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your 
desktop computer.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.
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Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen 
after the first stroke, you’ll see a drawing box indicating the boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. 

For more information on drawing and selecting drawings, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

For more information on using Pocket Word, tap Start and then Help.

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.
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Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. You 
can create new workbooks on your device, or you can copy workbooks from your desktop computer to your device. Synchronize 
workbooks between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a new file, tap Start, Programs, 
Pocket Excel, and then New. A blank workbook appears. Or, if you’ve selected a template for new workbooks in the Options 
dialog box, that template appears with appropriate text and formatting already provided. You can open only one workbook at a 
time; when you open a second workbook, you’ll be asked to save the first. You can save a workbook you create or edit in a variety 
of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, 
tap View and then Toolbar. 

If your workbook contains sensitive information, you can protect it with a password. To do so, open the workbook, tap Edit, and 
then Password. Every time you open the workbook, you will need to enter the password, so choose one that is easy for you to 
remember but hard for others to guess.

Tips for Working in Pocket Excel

When working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full-screen 
mode, tap Restore.

• Show and hide window elements. Tap View and then tap the elements you want to show or hide.
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View and then Freeze Panes. You 

might want to freeze the top and left-most panes in a worksheet to keep row and column labels visible as you scroll through 
a sheet.

• Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the split bar to where you want 
it. To remove the split, tap View and then Remove Split.

• Show and hide rows and columns. To hide a hidden row or column, select a cell in the row or column you want to hide. Then 
tap Format, then Row or Column, and then Hide. To show a hidden row or column, tap Tools, then Go To, and then type a 
reference that is in the hidden row or column. Then tap Format, then Row or Column, and then Unhide.

For more information on using Pocket Excel, tap Start and then Help.

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.
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Chapter 12 - Dolphin 9500/9550 HomeBase™
Overview

As the hub of your Dolphin 9500/9550 system, the Dolphin 9500/9550 HomeBase performs three important functions for your 
terminal – power, communications, and storage. 

Power 

The HomeBase provide power to the intelligent battery charging system incorporated into Dolphin terminals.

The charging/communication cradle also has an auxiliary battery well, located on the back of the cradle, allowing users to charge 
a spare battery.

Communications

Reliable data communications at speeds of up to 115k baud can be transmitted by the HomeBase through the RS-232 serial 
port. Using the full-speed USB port, data transmission rates of up to 12 Mbps are possible. 

The HomeBase cannot be “daisy-chained” but can be networked together using a serial or USB hub.

Convenient Storage 

Dolphin charging/communication peripherals provide a safe and convenient storage receptacle for your Dolphin terminal. 
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Dolphin 9500/9550 HomeBase Parts and Functions

Front Panel 

Terminal Well  

Place the Dolphin terminal in this well both to communicate with a host device. If the host device is a desktop computer 
that uses ActiveSync, synchronization begins immediately. While seated in the Terminal Well, the battery loaded in the 
back of the terminal charges. 

Auxiliary Battery Well

See Rear Panel on page 12-4.

DOCK LED   

Turns solid green when the Dolphin terminal is properly seated in the Dolphin HomeBase. When this light is on, the 
terminal is connected and the battery in the terminal is charging.

AUX BATT LED 

Indicates status of the battery charging in the Auxiliary Battery Well.   

This color means…

Orange the auxiliary battery is charging. 
Green the auxiliary battery has completed charging and is ready for use.

DOCK

AUX BATTERY

COMM

Terminal Well

DOCK LED

Auxiliary Battery Well

AUX Battery LED COMM LED
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COMM LED   

This is the communication LED. It indicates the status of data transfer between the Dolphin terminal and the host device 
the HomeBase is connected to.

The color of the LEDs mean different things if the HomeBase is using the serial or USB port connection.

If using the serial port:    

If using the USB Port: 

This color means…

Red Serial data is being sent from the Host Device to the Dolphin HomeBase. 
Green Serial data is being sent from the Dolphin HomeBase to the Host Device.
Orange Serial data is being sent at high data rates.

This color means…

Green LED A USB Connection is established with the host computer.
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Rear Panel 

Auxiliary Battery Well 

The HomeBase enables you to charge an additional battery in this well. It charges that battery whether a terminal is 
seated in the Terminal Well or not. This feature ensures that you can always have a fully-charged battery for your 
Dolphin terminal. See Using the Auxiliary Battery Well on page 12-5..

USB Port 

This USB Port is full-speed and 1.1 compliant. Using a USB cable, you can connect the HomeBase to a peripheral 
device such as a desktop computer or printer. When the Dolphin 9500/9550 is seated in the Terminal Well, it is 
connected to the peripheral device via the HomeBase.

RS-232 Communications Port 

Use a standard serial cable to connect this port to a host RS-232 device. 

Power supply connector 

Use this connector to attach a power supply to the HomeBase. The power supply provides 9.5V DC input for 
communications and battery charging.

Auxiliary Battery Well

DC Power JackRS-232 PortUSB Port
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Using the Auxiliary Battery Well

The auxiliary battery well located on the back of the HomeBase allows users to charge a spare battery. Charging a Dolphin 
terminal and a spare battery pack can be done simultaneously because the charging slot in the Auxiliary Battery Well operates  
independently of the battery installed in the terminal. 

The HomeBase senses when a battery pack is fully charged and automatically switches to maintain the battery at full capacity 
indefinitely.

To charge a spare battery in the auxiliary well, complete these steps:

1 Insert the end of the battery without the locking tab into the bottom of the auxiliary well opening.

2 Snap the battery into place with a hinging motion. 

3 Once the battery is inserted, you can use the AUX BATTERY LED to monitor the charging progress.
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Powering the Dolphin Terminal

The HomeBase charging/communication cradle powers the terminal while charging the battery installed in the terminal. It  
contains an intelligent battery charging system that protects the battery from being damaged by overcharging. Therefore, Dolphin 
terminals may be stored indefinitely in the charging/communication cradles without damage to the terminals, battery packs, or 
peripherals.

To charge a Dolphin terminal, complete these steps:

1 Insert a battery pack into the Dolphin terminal.

2 Place the terminal, imager window up and the LCD visible, in the terminal well of the cradle. 

3 Let it glide down into the well until it stops. 

4 When the Dolphin terminal is properly seated, the DOCK LED on the front of the cradle will be solid green.

5 The terminal is powered and the (if needed) the battery in it begins charging.
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Setting up communications

Set the Dolphin HomeBase on a dry, stable surface, such as a desktop near an electrical outlet. Be sure to provide enough 
workspace with good lighting for the user to view and operate the Dolphin terminal while it is in the HomeBase.

Communications types

RS-232

The HomeBase supports RS-232 communications through the RS-232 Communications Port located on the back of the 
device.The HomeBase interfaces the RS-232 signals from the host computer to the RS-232 signals of the Dolphin 9500/9550 
mobile computer. 

The HomeBase’s RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any RS-232 
device using a standard serial cable and communications software.

USB

The HomeBase also supports USB communications through the USB port located on the back. The HomeBase acts as a USB 
device, and interfaces the USB signals of the Dolphin 9500/9550 to the USB of the host computer. Using a standard USB cable, 
the HomeBase’s USB interface allows the Dolphin terminal to communicate with a personal computer or to be networked through 
a USB hub.

Note: The HomeBase should have only one type of interface cable connected at a time, either USB or RS-232.

Equipment requirements
To install and use the HomeBase, you need the following equipment:

• HomeBase connected to the appropriate power supply
• For RS-232 communications, a Serial cable 
• For USB communications, a USB cable 
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Installing the HomeBase for RS-232 communications

Connecting the Cables
Connect the HomeBase to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the rear of the HomeBase. The wiring of your cable depends on whether the other device is set up as 
a Data Communications Equipment (DCE) or Data Terminal Equipment (DTE) device. 

The HomeBase Communication Port is configured as a DCE device. To communicate with a DCE device, use either a null 
modem adapter in line with a standard RS-232 cable, or a null-modem serial cable. To communicate with a DTE device such as 
a computer, use a standard (or straight-through) RS-232 cable.  

You can make your own cables by following the pin configuration in the chart below. To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

Note: The HomeBase cannot be daisy-chained.

Powering the HomeBase

1 Connect the power supply to the charging/communication cradle. 

2 Plug the AC transformer into the Dolphin HomeBase 9.5 Volt DC power supply connector. 
The AC wall transformer provided can power only one HomeBase. 

HHP recommends that you leave the Dolphin HomeBase connected to its power source at all times, so that it is always ready to 
use.

HomeBase /Host Port 
(DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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HomeBase Serial Connector
The following diagram displays the serial connector of the HomeBase.  

The Home Base is at a right-angle to the printed circuit board (PCB). The ninth pin has a ring indicator (RI).

Configuring for RS-232 communication

Setting up the terminal

The Dolphin terminal may be configured for communications using the ActiveSync options as described in Chapter 2 or manually 
as described below.

To set Communications Properties, complete these steps:

1 Select Start > ActiveSync > Tools > Options. 

2 Select the PC tab.
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3 Check the Enable synchronization box and select the desired option from the pull-down list; 115200 Default is 
recommended for an RS-232 connection. 

4 Click OK.

5 Place the Dolphin in the cradle. The Dolphin 9500/9550 attempts to start an ActiveSync connection with the desktop 
computer automatically.

Setting up the Desktop Computer

ActiveSync must be installed and configured for RS-232 on the desktop computer to sync successfully with a Dolphin 9500/9550 
device that is configured for RS-232 communication. 
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The following graphic displays the correct ActiveSync Connection Settings on the desktop computer for an RS-232 connection.

Note: You can have the USB connection box checked in addition to the serial cable box without affecting processing. However, 
you would most likely use one or the other.
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft 12 - 11



Chapter 12 - Dolphin 9500/9550 HomeBase™ Installing the HomeBase for USB communication
Installing the HomeBase for USB communication

Required equipment:

• HomeBase with power supply
• USB Cable
• ActiveSync version 3.7 or above
• Windows® 98 second edition*, Windows® Me, Windows® 2000, or Windows® XP computer. 
Note: The HomeBase does not support Windows NT® when using a USB connection. This is because Windows NT does not 

support USB. 

*Windows® 98 second edition provides full USB support.

To install the HomeBase using USB

Complete these steps:

1 Plug in the power supply and connect it to the back of the HomeBase. 

2 Plug the USB cable into the back of the HomeBase.

3 Plug the other end of the USB cable into your PC. The Found New Hardware Wizard opens.

4 Check the CD-ROM drives check box and insert the driver CD provided into the CD tray on your desktop computer. 

5 Select the wceusbsh.inf file.

At this point, the hardware is installed and operating. You may need to reset your PC to complete the installation process. You 
may also need to remove and then re-insert the Dolphin 9500/9550 in the HomeBase to initiate a USB connection. You can verify 
that the USB driver is functioning by watching the COMM LED on the USB home base. It should be solid green. 

Setting up the Terminal 

To select ActiveSync options:

1 Select Start > ActiveSync > Tools >Options. 

2 Select the PC tab.
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3 Check the Enable synchronization box and select ‘USB Connection from the drop-down list. 

4 Click OK.

5 Place the Dolphin in the cradle. The Dolphin 9500/9550 attempts to start an ActiveSync connection with the desktop 
computer automatically.

Setting up the Desktop Computer

After the USB HomeBase is installed, you can use ActiveSync to connect to a Dolphin 9500/9550. These instructions assume 
that ActiveSync v3.1 is installed on your PC. The latest version of ActiveSync can be downloaded from www.microsoft.com.

The ActiveSync Connection Settings must be set as the following graphic indicates.

The Allow USB connection with this desktop computer box must be checked. Do not check the serial cable box.
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Communicating with the Dolphin 9500/9550 Terminal

To initiate communications between the Dolphin 9500/9550 and its peripheral, complete these steps:

1 Insert the Dolphin into the terminal well of the HomeBase. The DOCK LED on the cradle illuminates.
If the Dolphin is in sleep mode, it will awaken into active state.  

If the Dolphin does not turn on, or the LED does not light up, make sure that it is properly seated in the terminal well and 
that the power supply is properly connected to the cradle and plugged into a functioning AC outlet.

2 The Dolphin 9500/9550 terminal automatically opens ActiveSync to establish a connection. Data can then be transferred 
between the terminal and the peripheral it is connected to via the Home Base.

If communication does not occur, check the port connections to ensure that the cradle is correctly configured. 

COMM LED

When data transfer begins, the COMM LED on the cradle blinks red and green for an RS-232 connection or solid green for a 
USB connection. 
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Mounting the HomeBase

For convenience and storage, the HomeBase can be mounted on a flat, horizontal surface such as a desk or a flat, vertical 
surface such as a wall. 

When choosing a location, always bear in mind that 

• the mounting location must allow users easy access to the Auxiliary Battery Well, and
• the serial and USB ports face straight out of the rear panel - see Rear Panel on page 12-4. - and you will most likely want easy 

access to them in the future.

Desk Mounting

Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom to allow for secure desk attachment 
of the unit if desired.   

To mount the HomeBase, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts and 
bolts, secure the DIN rail to the desk or flat surface. 

Auxiliary Battery Well
Serial and USB port location (not in view) 

DIN rail (7.5 X 35 mm) 
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Wall Mounting

The following diagram displays how to wall-mount a Homebase.

Note: The back wedge of the Mounting Bracket contains an open slot for the power and communications cables. It is also 
designed with extra space between the slot and the back panel of the HomeBase to allow easy access to the power and 
communications ports. For more details on both ports, see Rear Panel on page 12-4.

Secure screws to  
the bottom panel

Fasten the screws 
to secure the  
HomeBase to the 
Mounting Bracket

Turn the secured 
HomeBase right 
side up.

Attach the bottom 
panel to the 
Mounting bracket 
- match the holes 
to the secured 
screws

Using the 
appropriate 
screws as shown, 
secure the 
Mounting Bracket 
to the wall or 
horizontal surface.
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Chapter 13 - Dolphin QuadCharger
Overview

The Dolphin® QuadCharger provides intelligent battery management for Lithium Ion (Li-Ion) Dolphin 9500/9550 battery packs.

Capacity

This device contains four individual slots that each hold and charge one battery. It can fully charge up to four Li-Ion batteries in 
four hours. Charging slots work independently to control the charging of individual battery packs. 

Compatibility

The QuadCharger is compatible with the batteries for all models in the Dolphin 9500/9550 family of hand-held computing devices.

CAUTION! Do not attempt to recharge any battery pack in the Dolphin 9500/9550 QuadCharger that is not manufactured by 
HHP specifically for this device. To do so will void your warranty and could damage the Dolphin 9500/9550 
QuadCharger. 

Charging process

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage. The charger also resets and calibrates battery 
pack data to accurately show battery status on the Dolphin display.
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Dolphin QuadCharger Parts and Functions

Front View 

Charging Slots

The QuadCharger contains four charging slots. Each holds one Dolphin 9500/9550 battery. When a battery is placed 
in each slot it immediately begins charging.   

Charge/Analyze Slot

This slot can be used to charge or analyze a battery. When a battery is placed in this slot, it begins charging just as it 
does in the other three slots. However, if you press the Analyze button, it runs the battery in the slot through the 
complete Analyze cycle. This is the only slot capable of analyzing a battery. 

Battery Capacity Indicator LEDS

Indicates the progress of the Analyze cycle of the battery in the Charge/Analyze slot.

Analyze Button

Press the Analyzer Switch to start a battery analyze cycle. Only the battery placed in the Charge/Analyze slot goes 
through the Analyze cycle. For more information, see Using the Battery Analyzer on page 13-7.

Status LEDs

A Status LED is located above each of the four battery pockets. The color of the LED indicates the charge status of the 
batteries in its slot. 

Status LED color This color indicates that the battery in the slot…

Green Has completed its charge cycle and is ready for use

Orange Is being charged at a maximum charge rate

Red Encountered and error during the most recent charge cycle

O

SLOT 4BATTERYCAPACITY

100%

0%
ANALYZE

CHARG
CHARGE/AE/ANALNALYZEYZE

1

2

3

4

Charging Slots

Status LEDs

Charge/Analyze Slot

Battery Capacity Indicator 
LEDS

Analyze Button
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Rear View

Battery Analyzer

This is Charge/Analyze slot from the rear view.

Power Switch

Press the toggle switch to turn the QuadCharger on and off. 

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. The universal power supply accepts input voltages 
between 90-265 volts.

1234

Swc

OCHARGE/ANALYZE

0%
ALYZE

LOT 4
TTERY

PACITY

0%

Power Supply ConnectorPower Switch

Battery Analyer
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Mounting the QuadCharger

The Dolphin QuadCharger should be on a dry, stable surface. To easily adapt the QuadCharger to your environment, it can be 
mounted on a flat, horizontal surface such as a desk or a flat, vertical surface such as a wall. 

When choosing a location, always bear in mind that 

• the mounting location must allow users easy access to power switch and power connector
• the QuadCharger should be oriented so that users can easily read the labels, especially for the Battery Analyzer.

Mounting with the DIN rail

All Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom panel to enable secure mounting. 

To mount the QuadCharger, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts 
and bolts, secure the DIN rail to the desk or wall.    

Desk Mounting

The following graphic displays how to desk-mount a QuadCharger.
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Wall Mounting

The following graphic displays how to wall-mount a QuadCharger.

Supplying power to the QuadCharger
The charger must be connected to a power source for any type of operation. 

CAUTION! Using a non-HHP power cord voids your warranty and could result in serious damage to the Dolphin 
QuadCharger’s circuitry.

Complete these steps:

1 Locate the AC power cord that came with the Dolphin QuadCharger. 

2 Plug the cord into the power supply connector on the back of the unit and then plug the power cord into a wall socket. 

3 Press the power switch. 
The Green power LED illuminates and the charger performs a self-diagnostic test that lasts approximately five seconds.

Inserting and removing battery packs 

Inserting

To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion. The Status LED for that particular slot illuminates orange when the battery has been 
properly inserted.

Removing

To remove a battery pack, push the locking tab down and pull the battery out from the charging slot with a hinging motion.

Storing Batteries

Recommendations

To maintain top performance from batteries, follow these storage guidelines:

• Avoid storing batteries outside of the specified temperature range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 
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Charging batteries in the QuadCharger

CAUTION! Do not attempt to recharge any battery pack in the Dolphin 9500/9550 QuadCharger that is not manufactured by 
HHP specifically for this device. To do so will void your warranty and could damage the Dolphin 9500/9550 
QuadCharger. 

Recommendation

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on 
charging. The recommended temperature range is 50° to 95° F (10° to 35° C). 

Complete these steps:

1 Set up the QuadCharger.

2 Supply the QuadCharger with power.

3 Insert batteries into the appropriate slots. The Status LED for each slot turns orange to indicate that the battery has begun a 
charge cycle.

4 When the Status LED turns green, the battery in the slot has completed charging.
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Using the Battery Analyzer 

Location

The fourth slot of the QuadCharger is known as the Charge/Analyze slot because it contains a battery analyzer. When a battery 
is placed in this slot and the Analyze button is pressed, it runs the battery through the Analyze cycle.

Note: The fourth slot is the only one that contains an analyzer. 

Analyze cycle

The Analyze cycle is initiated when a battery is placed in the Charge/Analyze slot and the Analyze button is pressed. At that time, 
only the battery in the Charge/Analyze slot is analyzed. 

In an Analyze cycle, batteries are completely discharged and then recharged to capacity. The indicator LEDs display just what 
that capacity is at the end of the cycle. The battery is completely reset and recalibrated. Resetting and calibrating batteries on a 
regular basis can provide longer and more consistent performance from those batteries. 

The length of time it takes for a battery to run through the complete Analyze cycle varies depends on initial state of the battery. 
Minimum time is 8 hours, maximum time is 12 hours.

Battery Capacity Indicator LEDs

The Battery Capacity Indicator LEDs are located along the right side of the Charge/Analyze slot. These LEDs illuminate after the 
completion of the Analyze cycle. Upon the completion of the final charge, these LEDs display the measured capacity of the 
battery. Battery capacity is displayed as a percentage of measured capacity/rated capacity. Each LED equates to 10%.   

Status LED

The Charge/Analyze slot also contains a Status LED in the upper, left corner of the slot. When this slot is used for regular 
charging, this LED operates in the usual manner; see Status LEDs on page 13-2.

When this slot is being used to analyze a battery, the Status LED functions as the following table describes:

To analyze a battery
Complete these steps:

1 Insert it into the Charge/Analyze slot (the fourth).

2 Press the Analyze button. The Status LED flashes orange to indicate that the analyzing cycle has begun.

3 Upon completion, the Status LED is solid green and the Battery Capacity Indicator LEDs display the current battery capacity.

CAUTION! Because the Dolphin QuadCharger is accumulating battery pack information during the entire Analyze cycle, it is 
important not to remove the battery until the cycle has been completed. 

Status LED color This color indicates that the battery in the slot…

Solid Green Has completed the Analyze cycle. 

Flashing Orange Is being analyzed. 

Solid Red Encountered an error during the Analyze cycle.
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Troubleshooting

If you encounter problems with your Dolphin QuadCharger, refer to chart below for possible solutions. If problems persist, please 
contact HHP Technical Support. 

Problem Issue

The “CHARGING” LED does not come on 
when I insert a battery pack into the Dolphin 
QuadCharger

Check the power connections on the Dolphin QuadCharger; make sure 
the POWER switch is ON and the battery pack is properly seated.

The red status LED comes on during 
charging.

Try to charge the battery in one of the other charging pockets. If the red 
Status LED comes on again, then the problem is associated with the 
battery pack. If the red status stays with the charging pocket, the problem 
is associated with the charging circuity.

The red status LED remains on without a 
battery in the charging pocket.

An error occurred during the self-diagnostic test for that particular 
charging pocket. Call HHP Product Service and request an RMA. 

See Warranty, Support, and Service on page 15-1. for additional 
warranty and return information.
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Chapter 14 - Dolphin Mobile Base
Overview

As the hub of your Dolphin 9500/9550 mobile data collection system, the Dolphin 9500/9550 Mobile Base charging/
communication cradle is ideal for use with both in-premise warehouse and in-transit data collection applications.

The Mobile Base performs three important functions: 1) charging, 2) communications, and 3) storage. 

Charging

The Mobile Base provides power to the Dolphin terminal which enables the terminal to charge its battery.

Communications

The Mobile Base can transmit reliable data communications at speeds of up to 115K baud through its RS-232 serial port.

Convenient Storage 

The Mobile Base is a safe and convenient storage receptacle for the Dolphin 9500/9550 terminal. 
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Chapter 14 - Dolphin Mobile Base Mobile Base parts and functions
Mobile Base parts and functions

Front Panel

The front panel of the Mobile Base has one slot. The following graphic features the Mobile Base with the Dolphin 9550 inserted 
into the Terminal Well.

Terminal Well Place the Dolphin 9500/9550 in this well to communicate with a host device and to charge the mobile 
computer’s battery.

Mounting Brackets Use these to mount the Mobile Base to a fixed location.

DOCK LED Turns solid green when the Dolphin Terminal is properly seated into the Dolphin Mobile Base.

COMM LED   Indicates the status of data transfer between the Host Device and the Dolphin Terminal

COMM LED color Indicates that…

Red Data is being sent from the Host Device to the Dolphin Mobile Base. 

Green Data is being sent from the Dolphin Mobile Base to the Host Device.

Orange Data is being sent at high data rates.

DOCK

COMM

Terminal 
Well

COMM LED

Mounting 
Brackets

DOCK LED
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Bottom Panel
The power supply and RS-232 connectors are located on the bottom of the unit.

Power Supply Connector

Use this connector to attach a power supply to the Mobile Base. The power supply provides power for communications 
and battery charging. The Dolphin 9500/9550 Mobile Base can be powered from an external DC power source of 
between 11 Vdc to 48 Vdc. 

The optional HHP cigarette lighter adapter cable allows the Mobile Base to be powered from a standard 12 Vdc cigarette 
lighter outlet in a vehicle. 

The Mobile Base can also be powered using the supplied pigtail power cable by “hard wiring” into the vehicle power bus.

CAUTION! Always be sure the power source is within the specified range and observe correct input voltage polarity.

RS-232 Communications Port 

Use a standard serial cable to connect this port to a host RS-232 device. See Mobile Base Serial Connector on page 
14-7. for details.

RS-232 Communications PortPower Supply Connector
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Powering the Dolphin Terminal

When seated in the Mobile Base, the Dolphin terminal receives the power to charge its battery and run its internal circuitry.

The Dolphin terminal can be stored indefinitely in the Mobile Base without damage to the terminal or the Mobile Base. Keep the 
Mobile Base plugged into the power source so that the Dolphin terminal battery pack stays fully charged.

Charging a Dolphin Terminal
The Mobile Base supplies charging power to the Dolphin terminal so that the terminal can monitor the charging of its battery pack. 
This charging method protects the battery from being damaged by overcharging. Therefore, the Dolphin terminal may be stored 
indefinitely in the Mobile Base without damage to the terminal, the battery pack, or the Mobile Base.

To charge a Dolphin terminal, complete these steps:

1 Insert a battery pack into the Dolphin terminal.

2 Place the terminal, imager window up and the LCD visible, in the Terminal Well of the Mobile Base. 

3 Let it glide down into the well until it stops. 

4 When the Dolphin terminal is properly seated, the DOCK LED on the Mobile Base turns solid Green.
The terminal begins charging automatically.
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Installing the Dolphin Mobile Base

To install the Dolphin Mobile Base, you need to mount it securely to an appropriate location and supply it with power.

Mounting the Mobile Base
The adjustable mounting bracket holds the terminal securely in place and gives the user a variety of options for mounting the 
Mobile Base. When selecting a location, keep in mind that the power supply and serial connectors point straight out the bottom 
of the Mobile Base. 

Complete these steps:

1 Loosen the Turnscrew located on the side of the bracket.

2 Attach the bracket to the Ball Joint on the back of the Mobile Base. 

3 Tighten the Turnscrew.

Powering to the Dolphin Mobile Base
Note: HHP recommends that you leave the Mobile Base connected to its power source at all times. 

The Mobile Base is powered via the power connector on the bottom panel; see Bottom Panel on page 14-3. Both the power and 
serial connectors are straight out, not at an angle.

The Mobile Base must be powered by a 12 to 48 volt DC source. 

Ball Joint
Turnscrew

Power supply and RS-232 
connectors (not in view
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Setting up for Communications with the Mobile Base

The Mobile Base RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any standard 
RS-232 device using a standard serial cable and communications software.

Connecting the Cables
Connect the Mobile Base to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the bottom of the Mobile Base. Plug the other end of the RS-232 serial cable into the correct port on 
the host RS-232 device. 

The wiring of your cable depends on whether the other device is set up as a Data Communications Equipment (DCE) or Data 
Terminal Equipment (DTE) device. 

The Mobile Base Communication Port is configured as a DCE device. To communicate with a DTE device such as a computer, 
use a standard (or straight-through) RS-232 cable. To communicate with a DCE device, use either a null modem adapter in line 
with a standard RS-232 cable, or a null-modem serial cable. 

RS-232 Pin Configuration 

Refer to this table if you want to make your own cables. To do so, you must determine if your host RS-232 device is 

• 9-pin or 25-pin and 
• configured as a DCE or DTE device.

Mobile Base /Host 
Port (DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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Mobile Base Serial Connector
The following diagram displays the serial connector of the Mobile Base.  

The Mobile Base connector is straight to the printed circuit board (PCB). The ninth pin sends 500mA at 5V power out. This can 
power a peripheral device such as a mobile printer provided that that peripheral device can accept 500mA at 5V.

Configuring the Dolphin Terminal
Communications Properties must be configured appropriately on the Dolphin 9500/9550 terminal for it to communicate with the 
Mobile Base.

To set Communications Properties:

1 Click Start > ActiveSync > Tools > Options. 

2 Click the PC Connection tab

3 Check the Enable Synchronization check box.
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Chapter 14 - Dolphin Mobile Base Configuring the Dolphin Terminal
4 Select the appropriate baud rate for connecting to the RS-232 Host Device; 11520 is the default.   

5 Click OK and close the ActiveSync window on the Dolphin 9500/9550.

6 Place the Dolphin in the Mobile Base. Sychronizations begins immediately.
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Chapter 15 - Warranty, Support, and Service
Limited Warranty

Hand Held Products, Inc., d/b/a HHP (“HHP“) warrants its products to be free from defects in materials and workmanship and to 
conform to HHP’s published specifications applicable to the products purchased at the time of shipment. This warranty does not 
cover any HHP product which is (i) improperly installed or used; (ii) damaged by accident or negligence, including failure to follow 
the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) modification or alteration by the 
purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface connections, (C) static electricity 
or electro-static discharge, (D) operation under conditions beyond the specified operating parameters, or (E) repair or service of 
the product by anyone other than HHP or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by HHP for the product at the time of purchase 
(“Warranty Period”). Any defective product must be returned (at purchaser’s expense) during the Warranty Period to HHP’s 
factory or authorized service center for inspection. No product will be accepted by HHP without a Return Materials Authorization, 
which may be obtained by contacting HHP. In the event that the product is returned to HHP or its authorized service center within 
the Warranty Period and HHP determines to its satisfaction that the product is defective due to defects in materials or 
workmanship, HHP, at its sole option, will either repair or replace the product without charge, except for return shipping to HHP.

EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL 
OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HHP’S RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS LIMITED TO THE 
REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT. IN NO EVENT SHALL HHP BE LIABLE FOR INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY LIABILITY OF HHP ARISING IN 
CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER SUCH LIABILITY ARISES FROM A CLAIM BASED 
ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE ACTUAL AMOUNT PAID TO HHP FOR THE 
PRODUCT. THESE LIMITATIONS ON LIABILITY SHALL REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HHP MAY 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES. SOME STATES, PROVINCES, 
OR COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and 
unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

The limited duration of the warranty for the Dolphin 9500 and Dolphin 9550 terminals is as described below:

• Terminals with an integrated imager are covered by a two-year limited warranty.   
• The limited duration of the warranty for the Dolphin HomeBase, Mobile Base, Mobile Charger, and QuadCharger is for one 

year. 
• The limited duration of the warranty for batteries is one year. The battery life will be greatly increased when following the 

specific battery instructions in the user guide. Batteries returned to HHP in this reduced state may or may not be replaced 
under this warranty.

• Use only power adapters approved for use by HHP. Failure to do so may result in improper operation or damage to the unit 
and will void the warranty.

• Touchscreens are covered only by a one-year limited warranty.

Hand Held Products, Inc. extends these warranties only to the first end-users of the products. These warranties are non-
transferable.
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How to Extend Your Warranty
HHP offers a variety of service plans on our hardware products. These agreements offer continued coverage for your equipment 
after the initial warranty expires. For more information, contact your HHP sales representative, customer account representative 
or the Product Service Marketing Manager or your Authorized Reseller. 

How Problems Should be Handled
Should the Dolphin terminal or any of the peripherals prove to be defective within the stated warranty period from the of date of 
purchase, return the product, as described in the RMA procedures below, and we will, at our option, repair or replace the product, 
to whatever extent HHP deems necessary to restore the product to proper operating condition, without any charge to you.

Application Support
If you have a question or problem with your Dolphin terminal or Dolphin peripheral, you can get technical assistance from HHP’s 
Application Support department. 
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Return Information

If you purchased the product from an Authorized HHP Reseller, contact the Reseller with the unit's serial number. Your Reseller 
will contact HHP, on your behalf, to arrange for the unit to be serviced.

Calling 
If you purchased the product directly from HHP, or have been instructed by your Reseller to contact HHP directly, call the 
Customer Services Department in your area to request a Repair Maintenance Authorization (RMA) number. 

Requirements

When calling for service at any of our repair facilities, please be prepared to give the following information:

• ·Product's type and serial number 
• ·Brief description of problem 
• ·Dated Proof-of-Purchase

If your equipment is still covered under the initial end-user's product warranty, please notify the Product Services Representative 
when you call.

Note: Do not ship repairs to the Latin American location.

North America

HHP Corporate Offices
Telephone: (800) 782-4263, option 3
Fax: (704) 566-6015
E-mail: ProductService@hhp.com

Latin America

HHP Latin America
Telephone:   +1 239-263-7600
Fax:   +1 239-263-9689
E-mail: LASupport@hhp.com

Asia Pacific

HHP Asia/Pacific
Telephone:   +852-2511-3050 
Fax:   +852-2511-3557
E-mail: chuie@hhp.com

Europe, Middle East, and Africa 
(EMEA)

HHP Europe
Telephone:+ 31 (0) 40 29 01 633
Fax: + 31 (0) 40 2901631
E-mail: EuroService@hhp.com

Brazil

HHP Brazil
Telephone: +55 (21) 2494-7060
Fax: +55 (21) 2494-5033
E-mail: suporte@hhp.com.br
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Shipping
CAUTION! You must have an RMA number to receive service from any of HHP’s repair facilities. Failure to obtain an RMA 

number before shipping your product to this repair facility can delay the processing of your repair request. 

Place the product in its original packaging with a copy of your original invoice (this helps avoid possible service delays) and ship 
the product prepaid to the appropriate address below. For your protection, we recommend you insure any equipment being sent 
to HHP.

Write the RMA number on the mailing label under the address.

Note: Please make note of the RMA number (if required) before shipping and the product's serial number for future reference.

Repair
After repair or replacement of the equipment, HHP will ship the product, at our cost, to your location. Non-warranty repairs will 
be returned, at the customer's expense, unless otherwise requested. Units currently under a service agreement will be shipped 
per the service agreement.

North and South America:

HHP
Products Services Department
7510 East Independence Blvd., #100
Charlotte, NC 28227-9411

Latin America

HHP Latin America
Telephone:   +1 239-263-7600
Fax:   +1 239-263-9689
E-mail: LASupport@hhp.com

Do not ship to this location.

Asia/Pacific

RM1104
Emperor Group Centre
288 Hennessey Road
Wanchai
Hong Kong - People’s Republic of 
China

The United Kingdom:

+ 0800-783-9718

Do not ship to this location.

HHP Brazil Japan Office

Bon Marusan 8F
3-5-1 Kanda-Jinbocho
Chiyoda-ku
Tokyo 101, Japan

Europe, Middle East and Africa:

HHP EMEA
Nijverheidsweg 9
Eindhoven, 5627 BT 
The Netherlands
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Appendix - A
Overview

This appendix provides useful tools for programming and managing your Dolphin 9500/9550 terminal. 

General Windows Keyboard Shortcuts
Use the keyboard shortcuts in the chart below to navigate the Dolphin 9500 and Dolphin 9550 terminal keyboards. These are 
standard keyboard shortcuts for WIndows applications.    

Press these keys, To…

CTRL + C Copy

CTRL + X Cut

CTRL + V Paste

CTRL + Z Undo

DELETE Delete

CTRL + RIGHT ARROW Move the insertion point to the beginning of the next word.

CTRL + LEFT ARROW Move the insertion point to the beginning of the previous word.

CTRL + DOWN ARROW Move the insertion point to the beginning of the next paragraph.

CTRL + UP ARROW Move the insertion point to the beginning of the previous paragraph.

SHIFT with any of the arrow keys Select more than one item in a window or on the desktop, or select text 
within a document.

CTRL+A Select all.

ALT+ENTER View properties for the selected item.

ALT+TAB Switch between open items.

ALT+ESC Cycle through items in the order they were opened.

ALT + Tap on Touch screen Right click

CTRL+ESC Display the Start menu.

ALT+Underlined letter in a menu name Display the corresponding menu.

Underlined letter in a command name on an open 
menu

Carry out the corresponding command.

BACKSPACE View the folder one level up in My Computer or Windows Explorer.

ESC Cancel the current task.
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Using the Cursor Keys
Use the cursor keys to navigate around on an application screen. The use of these keys can vary depending on the application.

Using the Modifier Keys
All three versions of the Dolphin 9500/9550 keyboard feature the standard PC keyboard modifier keys, Alt, Ctrl and Shift. There 
are two additional modifier keys located on the bottom row of the keyboard: one blue and one red. 

For single-handed operation, the Shift (SFT) key only modifies the next key pressed; it must be pressed and released before 
each key you wish to modify.

 

The Ctrl and Alt keys are located on the bottom row. Functions of the Alt and Ctl keys are dependent on the software application 
in use. 

The blue and red keys are used in combination with other keys to type the corresponding color-coded characters and functions. 
See the chart in A for key combinations for keyboard functions and special characters that use these keys.

The Red and Blue keys modify only the next key pressed; these keys must be pressed and released before each key you wish 
to modify to the Blue or Red case. 

Special Keys

SCAN Key 

The SCAN key “wakes” the terminal from sleep mode. Its position also allows convenient one-handed image-taking and/or bar 
code scanning. On the 9550 terminal, the SCAN key operates as an On or system wakeup control -- scanning is activated with 
the handle trigger.

Power Key

The Power key puts the terminal into Suspend Mode and also wakes terminal from suspend mode.

Shift (SFT)

The Shift key toggles the keyboard from upper case alphabet mode to lower case alphabet mode and back. Caps Lock may also 
be toggled by pressing the red modifier key followed by the Shift key or by double-tapping the Shift key. When Caps Lock is 
toggled on, the Shift key makes characters lower case; when it is toggled off, the Shift key makes keys upper case.

Enter (ENT)

The Enter key confirms data entry.

         Press To …

Move the cursor up one row or line.

Move the cursor down one row or line.

Move the cursor one character to the right.

Move the cursor one character to the left.
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Escape (ESC)

The Escape key performs a cancel action. 

Tab

The Tab key moves the cursor to the next tab stop or the next control on a form. 

Backlight

The Backlight key toggles the keyboard backlights on and off. The Backlight key also turns on the LCD backlight until the selected 
backlight time-out expires.

Number Lock (NUM)

This key is included only on the 43-key keyboard option which defaults to alphabetic mode. The Number Lock key toggles 
between the alphabetic and numeric modes. 

Alpha Lock (ALPHA)

This key is included only on the 35-key keyboard option which defaults to numeric mode. The Alpha key toggles between the 
numeric and alphabetic modes. 

Backspace (BKSP)

This key appears on both the 35 and 56-keyboard options. The Backspace key moves the cursor back one space for each time 
the key is pressed. Backspace is a shifted function on the 43-key keyboard version. To delete a single character, press Red key 
+ SP. To delete multiple characters, press Red key + SP and hold down the SP key.

Delete (DEL)

This key appears on both the 35 and 56-keyboard options. The Delete key deletes one character for each time the key is pressed. 
Delete is a shifted function on the 43-key keyboard version.
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43-Key Alpha/Numeric Keyboard   

Blue Key Functions and Characters  

Key Combination Function/Special Character

Blue key +  D - (minus)

Blue key +  H _ (underscore)

Blue key +  L =

Blue key +  P +

Blue key +  Q ;

Blue key +  R :

Blue key +  S *

Blue key +  T /

Blue key +  U @

Blue key +  X \

Blue key +  Y START
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Red Key Functions & Characters 

* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 43-key version of the Dolphin 9500/9550 keyboard.   

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  Q F1

Red key +  R F2

Red key +  S F3

Red key +  T F4

Red key +  U F5

Red key +  V F6

Red key +  W F7

Red key +  X F8

Red key +  Z INS (insert)

Red key +  SP BKSP (backspace)

Red key +  BACKLIGHT KEY DEL (delete)

Key/Key Combination Function/Special Character

NUM + SFT + A !

NUM + SFT + B @

NUM + SFT + C #

NUM + SFT + E $

NUM + SFT + F %

NUM + SFT + G ^

NUM + SFT + I &

NUM + SFT + J *

NUM + SFT + K (

NUM + SFT + M >

NUM + SFT + N )

NUM + SFT + O <
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Key combinations using Blue + SFT keys 

Miscellaneous key combinations  

Key/Key Combinations Function/Special Characters

SFT + Blue + T ?

SFT + Blue + X |

Key/Key Combinations Function/Special Characters

NUM + ALT + 3 + 9* ‘

NUM + ALT + 3 + 4*

*Hold the ALT key down as you type in the 
numbers.

“
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35 Key Numeric/Alpha Keyboard

Blue Key Functions and Characters   

Key Combination Function/Special Character

Blue key +  . +

Blue key +  , -

Blue key +  F1 ;

Blue key +  F2 :

Blue key +  F3 /

Blue key +  F4 \

Blue key +  SP +

Blue key + DEL -
August 2003 Dolphin® 9500/9550 Mobile Computer User’s Guide - Preliminary Draft Appendix - - 7



Appendix - A Key Combinations
Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 35-key version of the Dolphin keyboard. 

Key combinations using ALPHA + SFT Keys   

Miscellaneous Key Combinations    

Key/Key Combination Function/Special Character

ALPHA + SFT + 1 !

ALPHA + SFT + 2 @

ALPHA + SFT + 3 #

ALPHA + SFT + 4 $

ALPHA + SFT + 5 %

ALPHA + SFT + 6 ^

ALPHA + SFT + 7 &

ALPHA + SFT + 8 *

ALPHA + SFT + 9 (

ALPHA + SFT + 0 )

Key/Key Combinations Function/Special Characters

ALT + 3 + 9* ‘

ALT + 3 + 4*

*Hold the ALT key down as you type in the 
numbers.

“
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56 Key Full Alpha Numeric

Blue Key Functions and Characters  

Red Key Functions and Characters    

Key Combination Function/Special Character

Blue key +  . +

Blue key +  , -

Blue key +  A ;

Blue key + B @

Blue key +  E _

Blue key +  F :

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  A F1

Red key +  B F2

Red key +  C F3

Red key +  D F4
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* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 56-key version of the Dolphin keyboard.

Red key +  E F5

Red key +  F F6

Red key +  G F7

Red key +  H F8

Red key + I F9

Red key + J F10

Red key + K F11

Red key + L F12

Red key + M F13

Red key + N F14

Red key + O F15

Red key + P F16

Red key + Q F17

Red key + R F18

Red key + S F19

Red key + T F20

Red key + U F21

Red key + V F22

Red key + W F23

Red key + X F24

Red key + Y Z

Key Combination Function/Special Character
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Appendix - A Key Combinations
Key Combinations Using SFT & Number Keys   

Miscellaneous Key Combinations   

Key/Key Combination Function/Special Character

 SFT + 1 !

SFT + 2 @

SFT + 3 #

SFT + 4 $

SFT + 5 %

SFT + 6 ^

SFT + 7 &

SFT + 8 *

SFT + 9 (

SFT + 0 )

SFT + .  (period) >

SFT + , (comma) <

Key/Key Combinations Function/Special Characters

ALT + 3 + 9* ‘

ALT + 3 + 4*

*Hold the ALT key down as you type in the 
numbers.

“
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Appendix - A Internal Com Port Assignment Table
Internal Com Port Assignment Table 

Com Port Assignment

Com Port 1 Serial port. This is the 17-pin connector on the bottom panel of  
Dolphin 9500/9550 terminals.

Com Port 2 Bluetooth Module

If there is no Bluetooth hardware installed on the terminal, this com 
port is unassigned.

Com Port 3 Raw Infrared

Com Port 4 GSM Module

Com Port 5 USB virtual serial port

Com Port 6 IrDA, if IrDA is enabled. 

If IrDA is disabled, this com port becomes available.

Com Ports 7-9 Unassigned. 

These are available for selection only when connecting to devices 
that use virtual com ports such as Bluetooth.
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